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25 SMARTFIRE TUTORIALS 

 

 

25.1 INTRODUCTION TO TUTORIALS 

 

 

A number of SMARTFIRE tutorials have been developed. These are intended to provide 

users with practice and guidance in the basic aspects of loading a previously saved case, 

specification of a new case and simulation of fire modelling cases within the SMARTFIRE 

CFD engine. 

 

The first tutorial indicates how an existing geometry specification can be loaded into the set-

up environment, meshed by the automated meshing system and finally simulated within the 

SMARTFIRE CFD engine. 

 

The second tutorial creates the same case as used in the first tutorial but specifies it without 

loading a previously saved geometry. It also demonstrates how to turn on the six-flux 

radiation model and how to modify the fire output (power) curve. 

 

The third tutorial demonstrates how to construct multiple compartments within a region 

(separated by a compound partition) with a fire in one of the compartments. 

 

The fourth tutorial extends the experiences gained by performing the first three tutorials and 

creates a multiple room geometry with a fire in a corridor. The scenario is used to analyse the 

times before some of the monitored rooms exceed a critical temperature that is deemed to be 

hazardous. 

 

The fifth tutorial extends the previous tutorial case to include an extractor fan so that the 

effect of the extraction of heat can be seen when compared to the previous tutorial. 

 

The sixth tutorial uses the same scenario as for tutorial 4 but uses the gaseous combustion 

model and the multiple ray radiation model to compare the differences in the solutions when 

different modelling approaches are adopted. 

 

A set of advanced tutorials is also available. The advanced tutorials provide less detailed 

assistance than the tutorials in this document, but instead provide the user with example 

problems with which to practice using the various components and tools of the SMARTFIRE 

environment. The advanced tutorials also cover some of the newest and research features of 

the SMARTFIRE Environment such as the SMARTFIRE Scenario Designer (for CAD 

import) and the prototype Parallel MPI version of the SMARTFIRE CFD Engine.  
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25.2 TUTORIAL 1 

 

 

25.2.1 OVERVIEW  

 

 

This tutorial takes the user through the simulation of a simple room fire case using an existing 

saved case specification. The files needed to run this tutorial are included in the installation of 

SMARTFIRE and will be found in the user’s “work” directory. The case covered in this 

tutorial is for a centrally located fire in a single compartment (of dimensions of 2.8m x 2.8m 

x 2.2m height with a 0.74m wide x 1.83m high door). The fire is represented by a gas burner 

of dimensions 0.3m x 0.3m x 0.3m height with a constant heat release rate of 62.9kW. The 

walls are assumed to use a turbulent wall layer function for the calculation of heat loss. This 

case corresponds to one of the Steckler room fire experiments [1, 14, 15]. 

 

 

25.2.2 STEP 1: LOADING AN EXISTING GEOMETRY SPECIFICATION 

 

Run the SMARTFIRE case specification tool. Once the graphical user interface has opened, 

use the menu bar at the top of the window to select [File] and then select [Open]. The case to 

be loaded for this tutorial is in a directory called “A74_case” within the SMARTFIRE work 

directory. Use the file browser to go to this directory and select the file called 

“a74_case.smf”. This contains all of the geometric and physical properties for the 

specification of the case described above. Once the file has been selected and loaded, the 

viewer will show a 3D view of the room, together with all the important physical and 

geometric features, such as any vents, obstacles (if defined) and fires (See Figure 25-1). 
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Figure 25-1 Specification environment showing the “A74_case” geometry. 

 

Once you have opened the file, try experimenting with the viewing options. To start, you can 

select the [View] tab that allows you to change the way the viewer displays the geometry. 

You can try to rotate the geometry around the various axes, or chose to view a plan-view of a 

particular direction. It is recommended that you experiment with this and try to familiarize 

yourself with the various views offered. Additionally, you may decide to zoom in and change 

which items are visible at any time. Finally, you can get back to the original rotation by 

clicking on some of the pre-fixed views available. These view options are useful for checking 

the alignment of objects and checking the correctness of your geometry. 

The middle tab is the [Region] tab. This allows you to change the dimensions of the room as 

well as the wall-materials and names of the walls. Press the button [Edit properties] to choose 

another material for a wall after using the “unfolded room” area to select the current wall. 

The current wall (including floor and ceiling) will be displayed with a solid grey fill. 

  

The right tab is the [Object] tab. This allows you to add objects to the current region or to 

change the properties of any objects already created. You may like to experiment with 

moving and resizing the vent and fire. Additionally, you may want to change the physical 

properties of the fire by selecting it (by left-clicking on it with the mouse) as the current 

object and clicking on the object [Properties] button. An important point to note here is that 

only one object within the region will be current at one time and all of the buttons on the 

[Object] panel will cause an appropriate response for (and be related to editing) the current 

object. The current object is always displayed with grey shaded surfaces. You will notice that 

objects are drawn using coloured lines joining their vertices. The colours represent the object 

type. E.g. vents are green, fires are red and obstacles are blue. 
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25.2.3 STEP 2: CREATING A MESH FOR THE SIMULATION 

 

Once you are satisfied with the geometry and physics handling of the case you need to run 

the mesh creation system. This is a combination of automated meshing tool (a “friendly 

expert” to help you perform the task of meshing) and a manual mesh editing tool. These tools 

are seamlessly embedded into the SMARTFIRE system. The automated meshing system will 

take some of the decisions that are needed to set up an appropriate computational mesh for 

this geometry and the requested cell budget. 

 

To run the automated meshing tool from the main menu, choose the [Run] option, and then 

select [Create Mesh]. This will open the mesh creation tool with its own user interface. 

 

 

Figure 25-2 – Geometry type Meshing Rules selection dialog 

 

The automated meshing tool will first determine if the current geometry already has an 

existing mesh previously created. If one is available then the user will be given the option to 

load the existing mesh or to create a new one. It is assumed that no existing mesh is available 

or that the user will create a new mesh. The user is then asked to select the geometry type 

meshing rules they wish to use with the dialog in Figure 25-2 above. For many scenarios, the 

appropriate rules are normally automatically selected, but the user may wish to override 

SMARTFIRE’s suggestion if it does not seem to be the most appropriate type of geometry. 
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Figure 25-3 Additional Extended Region Dialog 

The meshing tool will then analyse, using the chosen rule set, the geometry and may present a 

“Additional Extended Regions” window (See Figure 25-3). Extended regions are used to 

ensure the flow is correctly developed within the region of interest and the flow will not 

adversely affected by the outlet boundary conditions at the edge of the extended regions. The 

user does not normally need to adjust the selection of Extended Regions. 
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Figure 25-4 Meshing tool showing selection of recommended cell budget. 

 

Once the meshing tool has loaded the case and considered the geometry, you will be asked to 

specify how fine a grid you wish to use in the simulation (see Figure 25-4). The automated 

meshing system will recommend a cell budget based on meshing expertise and the 

complexity of your geometry BUT it is up to you to decide if you want to use the 

recommended cell budget. Alternatively you can make the automated meshing tool try to 

produce the best mesh it can with a cell budget of your own choosing. Remember that a more 

refined grid will generally mean it is possible to obtain more accurate results but it will take 

longer to reach the solution. The automated meshing system will suggest a cell budget that is 

a reasonable compromise between accuracy and simulation time. You may accept the 

recommended value of cell budget by simply clicking on the [OK] button. This is likely to 

give a reasonable quality mesh using a fairly modest overall cell budget. The default 

refinement option should be used. When the meshing system finishes creating a mesh 

specification, the Mesh viewer window will be updated to show the mesh that has been 

created. The default mode of the Mesh viewer is for four views being the X-mesh, the Y-

mesh, the Z-mesh and the 3D domain view. (See Figure 25-5). You will find that many of the 

grid lines actually correspond to the edges of physical objects (such as the edge of the fire or 

edge of a vent). The lines are coloured as follows mauve = block model of the domain with 

edges on identified sub-region boundaries, light-blue = internal mesh line between (block 

boundaries). The vents are coloured green and any fires are red. Obstacles are dark-blue. 

 

Expert users may wish to use the [Coarse mesh] budget option to allow greater ease of 

creating a mesh manually. This option makes sure that all objects have at least the minimum 

number of required internal cells for their correct operation but only puts a single cell in non-

critical blocks. The user can then easily use the interactive manual mesh editing tool to add 

cells as required to each of the under-populated blocks.  
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If you are not satisfied with the mesh that the automated meshing tool has created then you 

may press the [Decline] button (to discard the current mesh) and specify a larger (or smaller) 

cell budget for re-meshing. Alternatively you may use the interactive editing mode to add (or 

subtract) cells from mesh blocks or change the distribution of cells. 

 

 

Figure 25-5 Meshing tool showing a four views of the mesh and geometry. 

 

There is also an option to evaluate the quality of the created mesh. This quality check can be 

used to determine if the cell aspect ratios (between the directions in a cell and between 

adjacent cells) are acceptable.  

 

Finally, when you are happy with the mesh, you need to press the [Accept] button to allow 

this mesh to be converted-to and saved-as a set of specification files for the CFD Engine to 

read. Pressing the [Accept] button will also cause the automated meshing tool to close and 

control will then return to the SMARTFIRE Case Specification Environment. 

 

25.2.4 STEP 3: RUNNING THE CFD ENGINE 

 

The final stage involves performing the numerical simulation itself using the CFD engine 

component of SMARTFIRE. To run the CFD engine select on the main menu item [Run] and 

the [Run CFD Engine] option. This will launch the numerical CFD engine that will 

automatically load the case specification and mesh that you have just created. You may have 

to be a little patient as this stage involves a considerable amount of file parsing, memory 

allocation and initialisation. Eventually the user interface for the CFD engine will appear 
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completely (See Figure 25-6). It should be noted that if you are using a fairly low resolution 

display then the CFD engine user-interface may display itself with more compact windows 

and a slightly different layout (e.g. more windows initially closed) in order to create an easily 

usable display. 

 

 

Figure 25-6 SMARTFIRE CFD Engine user interface at start up. 

 

In order to start the numerical simulation, you need to press the [Run] button, marked with a 

GREEN (GO) icon. This will start the simulation process. To halt the simulation at any time, 

press the [Halt] button marked by a RED (STOP) icon. You can also terminate the simulation 

at any point by pressing the [Exit] button (showing a little door icon). There are a number of 

extra buttons and other controls that allow experts to control the configuration of the solution 

process. However, non-experts are not recommended to make any changes to the control 

settings unless such changes are recommended in the user guide. 

 

The graphical windows of the user interface present various views of the data and the status 

of the simulation during the simulation process. The things to look for are: 

 

1) The residual graphs that are indicators of the convergence of the solved and calculated 

variables of the numerical simulation process (Top right). 

 

2) The monitor values and variable residuals (current solution error states) of various 

important variables are shown in the status window (Bottom left). 

 

3) The emerging vector flow and temperature contour patterns for the particular selected 

slice of the room in the visualizer window (Bottom right). 
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4) The data ranges for each variable displayed in the status window (Bottom left). 

 

5) The control window has progress bars in its bottom right corner (below the 

visualisation buttons). These bars indicate solution progress. The upper bar is filled 

once every sweep whilst the lower bar is filled once for the whole configured 

simulation (Top left). 

 

6) The status window has displays indicating the sweep number and time step number 

(only for transient simulations) to indicate the current stage of processing (Bottom 

left).  

 

7) The status window has estimates for the CPU time taken and remaining. These are 

only estimates but can give a reasonable approximation of the expected duration of a 

simulation (Bottom left). 

 

8) A key feature of SMARTFIRE is the access to save a bookmark and restart from 

saved bookmarks at any time. The control button labelled [Mark] will drop a 

bookmark of the current stage of the solution into a database for this case. The button 

labelled [Restart] allows a previous bookmark state to be loaded as if subsequent 

processing had not happened. This can be invaluable for problematic simulations that 

need expert solution control or simply for saving data for future examination (Top 

left). 

 

9) There is a control button labelled [Plots] that allows you to define line graphs through 

the data. These plot line graphs are updated as the solution progresses (Top left). 

 

If you need to change the particular viewing slice through the room then you can select the 

[Visuals] button. This will open the visual configuration window (See Figure 25-7). 
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Figure 25-7 Visual Configuration showing slice and display options. 

 

This dialogue allows you to select a particular slice through the room (and the nature of the 

visualisation to be displayed). For the case shown in this tutorial, you should select the 11
th

 

“X against Y” slab on the Z direction (referred to as Z=11). This should allow you to see the 

fire, the door and the emerging fire plume that first goes up to the ceiling and then leans over 

towards the back of the room because of cold air rushing into through the bottom of the door. 

An interesting alternative is to view a slice through the first slab on the y axis (height). This 

will pinpoint the fire within the room. 
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Figure 25-8 Visualisation of temperature and velocities for mid Z-slice. 

 

Other features that you may control, using the visual configuration window, are the variables 

used for the contour and vector plots and the types of plots used. Try to experiment with 

some of these settings and examine the pull down lists to see what other variables are 

available for visualisation. See how changing the settings affects the visual display. 

 

25.2.5 STEP 4: EXITING THE CFD ENGINE 

 

To exit the code, you first need to exit the CFD engine interface using the [Exit] button. On 

normal termination, the SMARTFIRE CFD engine will save a number of files that can be 

used for further visual post-processing (abnormal termination will not save any files and is 

encountered when the main window [X] button is pressed). Finally the CFD engine user 

interface will close and you will get back to the original geometry set-up tool. If you want to 

save any changes you have made to the fire modelling case, select the [File] item and then the 

[Save] option from the main menu. 

 

You may like to try saving your work as a new case because it is generally necessary to 

create a new case for each new geometry and simulation you want to run. To save the 

scenario specification as a new case, you should choose the [File] item from the main menu 

and then the [Save As] option, and enter a new case name in the file browser window. The 

case specification environment will create a directory folder, of the same name, to contain all 

files relating to your new case and it will save the “new_case_name.smf” file in this 

directory. 
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It should be noted that the case directory (for a completed simulation) will contain many files 

that have been created during this exercise. Some of these files can be used for graphical 

post-processing and for re-starting this simulation from the stage at which it was ended. Also 

there may be data capture files that were saved during your simulation.  

 

You have just completed a fire field modelling simulation, using SMARTFIRE. 

 

This is the end of tutorial 1. 
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25.3 TUTORIAL 2 

 

 

25.3.1 OVERVIEW 

 

This tutorial takes the user, step by step, through the specification and modelling of a simple 

room fire case using the specification environment. The case covered in this tutorial is a 

centrally located fire in a single compartment of dimensions 2.8m x 2.8m x 2.2m height with 

a 0.74m wide x 1.83m high door. The fire is represented by a gas burner of dimensions 0.3m 

x 0.3m x 0.3m height with a linear ramped heat release curve up to 62.9kW in 20 seconds. 

The six-flux radiation model is used to represent radiative heat transfer. The walls are 

assumed to use a turbulent wall layer heat transfer function. This case corresponds to one of 

the Steckler room fire experiments [1, 2, 3]. This case is essentially the same as the case in 

tutorial 1 but it must be specified manually using the case specification environment. 

 

 

25.3.2 STEP 1: STARTING THE CASE SPECIFICATION TOOL 

 

Run the SMARTFIRE case specification tool. Once the graphical interface has opened, use 

“Region” tab (if not already selected) to show the region editor panel. You will be shown a 

visual depiction of an empty, default sized region with no geometry objects defined (See 

Figure 25-9).  

 

 

Figure 25-9 Specification tool showing an empty default initial region. 
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Note the wall surface selection tool (unfolded box) on the left hand side of the display and the 

corresponding shaded surface in the region display. 

 

25.3.3 STEP 2: CREATING THE DOMAIN 

 

Enter the dimensions of the region in metres using the three spin boxes (See Figure 25-10). 

You can select on the spin increment and decrement buttons to change the displayed size by 

steps of 0.1m or you can double-click the value and type a new one in directly and press the 

enter button to confirm your input. As specified in the case description, the dimensions are 

set as follows: x-size = 2.8m, y-size = 2.2m and z-size = 2.8m. You do NOT need to change 

the wall behaviour for any of the region walls because the default behaviour is acceptable for 

this case. 

 

 

Figure 25-10 Specification tool showing entry of correct region sizes. 

 

25.3.4 STEP 3: CREATING GEOMETRY OBJECTS 

 

Once the region has been sized correctly you can create all of the geometry objects (fires, 

obstacles and vents) that are required for the simulation. In this tutorial you will need to 

create a fire and a vent. 
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Figure 25-11 Specification tool showing object editor panel. 

 

Select the “Object” tab to display the object editor panel (See Figure 25-11). There are 

initially no objects defined so the panel only displays a “New Object” button. Select the 

button to open the new object menu. This menu presents a list of all of the object types 

available. Select the “VENT” object and press the “Add” button (See Figure 25-12). 

 

 

 

Figure 25-12 New object selection dialogue used to create a new VENT. 
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The dialogue window will close and a default sized rectangular vent will be added to the 

region display at a default location (See Figure 25-13). The object editor panel will modify 

itself to match the currently selected object type (in this case the vent you have just created). 

The current object will always be displayed using its own typed colour key for the edges and 

shaded GREY faces. Non current objects do not have GREY shaded faces. 

 

 

Figure 25-13 Specification tool showing new VENT at default location. 

 

In this simulation it is required that the vent (doorway) has a width = 0.74m and height = 

1.83m and be centrally located on one of the walls. Arbitrarily, the vent will be placed on the 

high-x surface of the region. Use the “unfolded region” display to choose a region face so 

that the vent appears on the high-x surface of the region (See Figure 25-14).  
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Figure 25-14 Specification tool using the “unfolded” plane selector. 

 

Enter the size and location of the vent in the spin boxes on the object editor panel (See Figure 

25-15). Since this is a 2 Dimensional object only the relevant spin boxes will be enabled for 

entering sizes and locations. In the case of the doorway specified in the case description you 

will need to enter the following values provided that the vent is on the high-x surface: y-size 

= 1.83m, z-size = 0.74m and y-location = 0.0m and z-location = (2.8m / 2) - (0.74m / 2) = 

1.03m. The vent will now be correctly sized and centrally located on the high-x surface of the 

domain. 
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Figure 25-15 Specification tool showing correct VENT size and position. 

 

The final object that needs to be created is the fire source. Select the button labelled “New” in 

order to choose another object type to add to the region. This time select the “SIMPLE FIRE” 

item from the list and press the “Add” button (See Figure 25-16). 

 

 

Figure 25-16 New object dialogue used to create a new SIMPLE_FIRE. 
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A default sized cube will placed at the low coordinate (0.0, 0.0, 0.0) location of the region 

and will be made current (GREY faces) (See Figure 25-17). 

 

 

Figure 25-17 Specification tool showing default SIMPLE_FIRE. 

 

Enter the sizes of this fire using the spin boxes. In this case the dimensions are x-size = 0.3m, 

y-size = 0.3m and z-size = 0.3m. The locations are x-location = (2.8m / 2) - (0.3m / 2) = 

1.25m, y-location = 0.0m and z-location = (2.8m / 2) - (0.3m / 2) = 1.25m. Enter these values 

in the appropriate spin boxes and the fire will be centrally located and correctly sized (See 

Figure 25-18). The fire will have a default fire output curve specified (a fire with a constant 

Heat Release Rate of 50kW) which is not appropriate to the case specification. Select the 

button labelled “Properties” to access the fire properties editor window. It should be noted 

that the “Properties” button will always open an editor window appropriate to the type of the 

currently selected object and the values and settings displayed will be those of the current 

object. 

 

The fire properties window allows you to choose a fire behaviour curve from a number of 

given or parametric heat release curves. In the case description, the fire is required to be 

linearly increasing with time for 20 seconds up to a final sustained value of 62.9kW (See 

Figure 25-19).  
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Figure 25-18 Specification tool showing FIRE position and size. 

 

 

Figure 25-19 Fire properties dialogue showing default fire settings. 

 

This “linear” type of fire growth corresponds to an “Expert” parametric curve with a 

coefficient for linear time as B = (62.9 / 20) = 3.145kW. Select the “Expert” radio button to 
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enable the parametric curve and enter 3.145 into the B value spin box. All of the other spin 

box values should be set to zero. I.e. A = C = D = E = 0.0 (See Figure 25-20). 

 

 

Figure 25-20 Fire properties showing a linear fire curve to 62.9kW in 20.0s. 

 

Enter 0.0 in the Fire start time spin box and 20.0 in the Fire end time spin box. You should 

notice that the red power curve is indeed displayed as a linear ramp up from left to right and 

the upper right hand edge has a value of 62.9 displayed above it. This is the heat release curve 

required by this tutorial. Select the OK button to accept the settings and close the dialogue. 

 

If you are confused about setting the specified fire curve, you may alternatively enter a 

simple constant fire of the correct power by selecting the “Constant” curve type and entering 

62.9 into the A spin box (which will be the only setting active for a constant fire). 

 

25.3.5 STEP 4: DEFINING THE PROBLEM TYPE 

 

Select the “Scenario” menu from the main menu bar and choose the “Problem Type” item. 

This will open a configuration window that allows the simulation controls to be modified 

(See Figure 25-21). The Steckler A74 case was found to reach near steady state after 30 

minutes BUT indicative results can be obtained after 3 minutes. In order to perform a 

reasonably short simulation it will be necessary to change the simulation time characteristics. 

An acceptable simulation can be performed using 18 time steps of 10 seconds per time step 

and 50 iterations per time step. Enter the following values to configure the simulation 

characteristics: Time step size = 10.0s, Number of time steps = 18 and Number of iterations 

per time step = 50. This will give (18 x 10) = 180 seconds of simulated time. I.e. 3 minutes. 
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Figure 25-21 Expert Problem Type showing the type of simulation. 

 

To enable radiation you should select the “Radiation model” check box. You may need to go 

to the "Setup…" for the radiation model to check that the correct type of radiation model is to 

be used. By default SMARTFIRE uses the Six-flux radiation model. None of the other 

parameters need to be changed from their default values but the user is advised to glance at 

the other global control items that can be configured in this window. 

 

25.3.6 STEP 5: SAVING TO A NEW CASE DIRECTORY 

 

Now that the simulation has been fully specified it is necessary to save the geometry and 

physics specification to a unique case directory where all of the other case-related simulation 

files will be created and stored. Select the main menu “File” option and choose the “Save 

As...” item. This will open a file browser that is viewing the contents of the SMARTFIRE 

work directory (See Figure 25-22). Enter a unique name for this simulation case. It is 

recommended that you choose a representative name that you can use to easily identify this 

case again in the future. For example you could enter the name “Tutorial_2" and then select 

the “Save” button. This will create a directory (folder) called Tutorial_2 and will save the 

specification file “Tutorial_2.smf” into the new directory. You should not create new case 

directories yourself since SMARTFIRE expects to do this whenever you save a new case. 
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Figure 25-22 Using File “Save As...” to specify a new case name. 

 

STEP 6: FINISHING SPECIFICATION AND STARTING CFD ENGINE 
 

As with Tutorial 1 you are now ready to create a mesh specification, a specification script file 

and to simulate this case in the CFD engine. The steps to achieve this are described in more 

detail in Tutorial 1 but are enumerated here in succinct form for completeness. 

 

• Use the main menu “Run” and “Create Mesh” to run the mesh generation system. 

• Choose a cell budget (as NX, NY and NZ) for simulating this case (it is recommended that, 

for this scenario, a total cell budget of 11000 or so cells gives a reasonable quality mesh). 

• "Accept" the created mesh to create the geometry file and specification script - and this will 

also exit from the automated meshing tool. 

• Start the CFD engine by selecting the main menu items “Run” and “Run CFD Engine”. 

• Wait for the CFD Engine to initialise. 

• Start the CFD Engine using the “Run” button. 

 

At any stage of the processing you may stop the CFD engine, using the “Stop” button, in 

order to change the visualisation view, to explore the data, to define graphs or to modify the 

control parameters BUT you must wait for the current sweep to end (upper GREEN progress 

bar must have reached the right hand edge in the Control window). 

 

When you have finished you should stop the simulation and press the Control panel “Exit” 

button to terminate the CFD engine. 

 

This is the end of tutorial 2. 
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25.4 TUTORIAL 3 

 

 

25.4.1 OVERVIEW 

 

 

This tutorial takes the user, step by step, through the specification and modelling of a 

multiple room fire scenario using the specification environment. The case covered in this 

tutorial is an elongated dual compartment of dimensions 6.1m x 3.0m x 2.5m height with a 

1.0m wide x 2.0m high door at one end of the long-axis. The region is divided equally into 

two compartments by a 0.1m thick partition half-way along the long axis with a doorway of 

the same location and dimensions as the end vent (door). There is a centrally located 1.0m x 

1.0m window on the side wall of the compartment without an external door. The fire is 

centrally located in the compartment that does not have an external door and is represented 

by a gas burner of dimensions 0.5m x 0.5m x 1.0m height with a constant heat release rate of 

100.0kW. Radiation will not be used. 

 

 

25.4.2 STEP 1: STARTING THE CASE SPECIFICATION TOOL 

 

Run the SMARTFIRE case specification tool. Once the graphical interface has opened, use 

the [Region] tab (if not already selected) to show the region editor panel. You will be shown 

a visual depiction of a default region with no geometric objects defined (See Figure 25-23). 

 

 

Figure 25-23 Specification tool showing default sized region. 
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25.4.3 STEP 2: CREATING THE DOMAIN 

 

Enter the dimensions of the region in metres using the three spin boxes. You can select on the 

spin increment and decrement buttons to change the displayed size by steps of 0.1m or you 

can double-click the value and type a new one in directly and press the enter button to 

confirm your input. As specified in the case description above you need the dimensions to be 

set as follows: x-size = 6.1m, y-size = 2.5m and z-size = 3.0m (See Figure 25-24). You do 

NOT need to change the wall behaviour for any of the region walls because the default 

behaviour is acceptable for this case. 

 

 

 

 

Figure 25-24 Specification tool showing correctly sized region. 

 

25.4.4 STEP 3: CREATING GEOMETRY OBJECTS 

 

Once the region has been sized correctly, you can create all of the geometry objects (fires, 

obstacles and vents) required for the simulation. In this tutorial you will need to create a fire, 

two vents (a window and a door), an obstacle (that is the partition wall) and a portal (which 

makes a doorway through the partition wall). 

 

Select the [Object] tab to display the object editor panel. There are initially no objects defined 

so the panel only displays a [New Object] button (See Figure 25-25) which you should select 

to open the new object selection list. The dialogue window presents a list of all of the object 

types available for inclusion in your simulation. Select the “VENT” object type and press the 
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[Add] button. The dialogue window will close and a default sized rectangular vent will be 

added to the region display at a default location (See Figure 25-26). The object editor panel 

will modify itself to match the currently selected object type (in this case the vent you have 

just created). The current object will always be displayed using its own typed colour key for 

the edges and shaded grey faces. Non current objects do not have grey shaded faces. 

 

 

 

Figure 25-25 Specification tool showing the object panel. 
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Figure 25-26 Specification tool showing new VENT at the default location. 

 

In this simulation it is required that the vent (doorway) have a width = 1.0m and height = 

2.0m and be centrally located on the high-x wall. Use the “unfolded region” display area to 

choose the high-x region face so that the vent appears on the high-x surface of the region. 

 

Enter the size and location of the vent in the spin boxes on the object editor panel. Since this 

is a constrained 2D object, only relevant spin boxes will be enabled for entering sizes and 

locations. In the case of the doorway specified in the case description you will need to enter 

the following values provided that the vent is on the high-x surface: y-size = 2.0m, z-size = 

1.0m and y-location = 0.0m and z-location = (3.0m / 2) - (1.0m / 2) = 1.0m. The (door) vent 

will now be correctly sized and centrally located on the high-x surface of the domain (See 

Figure 25-27). 
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Figure 25-27 Specification tool showing door position and size. 

 

Create another “VENT” object using the [New] button but this time use the “unfolded 

region” display to locate it on the high-z surface of the region. Enter the following sizes and 

locations for the side window: x-size = 1.0m, y-size = 1.0m, x-location = (3.0m / 2) - (1.0m / 

2) = 1.0m and y-location = (2.5m / 2) - (1.0m / 2) = 0.75m. The (window) vent will now be 

correctly sized and centrally located for the first compartment (See Figure 25-28). 
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Figure 25-28 Specification tool showing window position and size. 

 

Select the [New] button and choose to add an “OBSTACLE”. Enter the following sizes and 

locations to create the partition between the two compartments: x-size = 0.1m, y-size = 2.5m, 

z-size = 3.0m dimensions and x-location = 3.0m, y-location = 0.0m, z-location = 0.0m 

locations (See Figure 25-29). 

 

You may like to note that the OBSTACLE objects that you create will all have the default 

material type “Wall_Default_Material” which, in this version of SMARTFIRE, is set to 

concrete. If you require the obstacles to have different material characteristics then you 

should select the object [Properties] button when the required object is current and choose an 

appropriate material from the library of material definitions provided. For the purposes of this 

tutorial you do not need to change the material type. 

 

Select the [New] button and choose to add a “PORTAL”. Enter the following sizes and 

locations to create the second part of a three component partition arch that makes a doorway 

between the two compartments: x-size = 0.1m, y-size = 2.0m, z-size = 1.0m dimensions and 

x-location = 3.0m, y-location = 0.0m, z-location = 1.0m locations (See Figure 25-30). 

 

Expert users may wish to use the [Coarse mesh] budget option to allow greater ease of 

creating a mesh manually. This option makes sure that all objects have at least the minimum 

number of required internal cells for their correct operation but only puts a single cell in non-

critical blocks. The user can then easily use the interactive manual mesh editing tool to add 

cells as required to each of the under-populated meshing blocks.  
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Figure 25-29 Specification tool showing the partition. 

 

 

 

Figure 25-30 Specification tool showing a portal connecting the two compartments 

through the partition. 
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The final object that needs to be created is the fire source. Select the button labelled [New] in 

order to choose another object type to add to the region. This time select the 

“SIMPLE_FIRE” type from the list and press the [Add] button. A default sized cube will 

placed at the low co-ordinate (0.0, 0.0, 0.0) location of the region and will be made current 

(grey faces). Enter the sizes of this fire using the spin boxes. In this case the dimensions are 

x-size = 0.5m, y-size = 1.0m and z-size = 0.5m. The locations are x-location = (3.0m / 2) - 

(0.5m / 2) = 1.0m, y-location = 0.0m and z-location = (3.0m / 2) - (0.5m / 2) = 1.0m. Enter 

these values in the appropriate spin boxes and the fire will be centrally located in the first 

compartment and correctly sized (See Figure 25-31). 

 

 

 

Figure 25-31 Specification tool showing fire location and size. 

 

The fire will have a default fire output curve specified (constant 50kW fire) which is not 

appropriate to this case specification. Select the button labelled [Properties] to access the fire 

properties window. 

 

The fire properties window allows you to choose a fire behaviour curve from a number of 

given or parametric heat release curves. In the case description the fire is required to be a 

constant heat output value of 100.0kW. Select the [Constant] power curve type radio button 

to enable the constant curve and enter 100.0 into the [A] value spin box (See Figure 25-32). 

All of the other spin box values will be disabled for constant power fires. There is no need to 

change the fire start and end times because constant fires are assumed to start at t=0.0 

seconds and continue indefinitely. Select the [OK] button to close the dialogue. 
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Figure 25-32 Fire properties window showing constant fire of 100.0kW. 

 

25.4.5 STEP 4: DEFINING THE PROBLEM TYPE 

 

Select the [Scenario] menu from the main menu bar and choose the [Problem Type] item. 

This will open a configuration window that allows the simulation controls to be modified 

(See Figure 25-33). It is estimated that this case will reach near steady state after 30 minutes 

or so BUT indicative results can be obtained after 3 minutes. In order to perform a reasonably 

short simulation it will be necessary to change the simulation time characteristics. An 

acceptable simulation can be performed using 18 time steps of 10 seconds per time step and 

50 sweeps per time step. Enter the following values to configure the simulation 

characteristics: Time step size = 10.0s, Number of time steps = 18 and Number of sweeps per 

time step = 50. This will give (18 x 10) = 180 seconds (i.e. 3 minutes) of simulated time. 

 

Radiation should not be enabled so make sure that the check box for the Radiation activation 

is empty (i.e. not ticked or crossed). None of the other parameters need to be changed from 

their default values but the user is advised to glance at the other global control items that can 

be configured in this window. 
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Figure 25-33 Problem type dialogue. 

 

25.4.6 STEP 5: SAVING SPECIFICATION TO A NEW CASE DIRECTORY 

 

Now that the simulation has been fully specified it is necessary to save the geometry and 

physics settings to a directory where all other case-related simulation files will be created, 

accessed and stored. Select the main menu [File] option and the [Save As] item. This opens a 

file browser in the work directory. Enter a unique name for this case (See Figure 25-34). 
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Figure 25-34 File [Save As] dialogue being used to give a name to the case. 

 

It is recommended that you choose a representative name that you can use to easily identify 

this case again in the future. For example you could enter the name “Tutorial_3” and then 

select the [Save] button. This will create a directory (folder) called Tutorial_3 and will save 

the specification file “Tutorial_3.smf” into the directory. You should not create case 

directories yourself since SMARTFIRE expects to do this for you when you save a new case. 

 

25.4.7 STEP 6: FINISH SPECIFICATION AND START CFD ENGINE 

 

You are now ready to create a mesh specification, a specification script file and to simulate 

this case in the CFD engine. The steps to achieve this are described here in succinct form: 

 

• Use the main menu [Run] and [Create Mesh] to run the automated meshing system. 

• Choose a cell budget (as NX, NY and NZ) for this case (it is recommended that a 

total cell budget of 20000 or so cells will give a reasonable quality mesh for this 

scenario). 

• [Accept] the mesh to create the geometry file and specification script - this will also 

exit from the automated meshing tool. 

• Start the CFD engine by selecting the main menu [Run] and [Run CFD Engine]. 

• Wait for the CFD Engine to initialise. 

• Start the CFD Engine using the [Run] button. 
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Figure 25-35 CFD engine at end of full simulation (rearranged windows). 

 

At any stage of the processing you may stop the CFD engine, using the [Halt] button, in order 

to change the visualisation view, to explore the data, to define graphs or to modify the control 

parameters BUT you must wait for the current sweep to end (upper green progress bar must 

have reached the right hand edge in the Control window). 

 

The final image shows the end of the configured simulation (See Figure 25-35). You should 

notice that the User Interface windows have been reorganised slightly to present this (slightly 

elongated) case more clearly. 

 

Stop the CFD code and press the Control panel [Exit] button when you want to finish. 

 

This is the end of tutorial 3. 
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25.5 TUTORIAL 4 

 

 

25.5.1 OVERVIEW  

 

 

This tutorial takes the user through the specification of a moderately complex multiple room 

geometry using the SMARTFIRE case specification tool, meshing the case using the 

automated interactive meshing tool and simulating the case using the SMARTFIRE CFD 

Engine. The simulation case represents one corner of a larger building where the fire analysis 

is to be conducted. This study is based around a large fire in the main corridor and 

investigates the impact this has on the temperatures in the adjacent rooms. The plan view of 

the geometry is as follows: 

 

 

Figure 25-36 Plan view drawing showing the room layout geometry. 

 

Certain assumptions have been made to simplify the specification as follows: 

 The rooms are all assumed to be open plan, and all of the doorways and windows are 

fully open for all of the simulation. 

 The doors on the end of the corridor are assumed closed throughout the simulation and 

that the fire will not affect their structural integrity. There are actually windows present 

on the large outer wall of the largest room but these are assumed closed (and are hence 

not modelled) during the period of the simulation.  It should be noted that the windows 

could be made open, but this would require an additional extended region and hence 

require additional simulation time. 

 Small air leaks around closed doors or windows are ignored and the heat transfer 

through the walls is considered to be negligible compared to heat transfer due to other 

processes, in the duration of the simulation.  Again, these are merely simplifying 
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assumptions for the purposes of this example.  They can be accommodated within a 

SMARTFIRE simulation but are not used in this demonstration. 

 The corridor is assumed to have no combustible materials, which can support fire 

spread or secondary ignition.  

 

The geometry of this case requires a large number of OBSTACLE objects to make the 

internal walls. It is assumed that the user in familiar with the construction, correct sizing and 

positioning of such objects - from the previous tutorials. 

 

The fire is assumed to be a cleaning trolley fire at one end of the corridor. The fire reaches a 

peak heat release rate of 2MW in two minutes. Since the fire is in the corridor and will 

prevent conventional means of egress from the building, we are actually interested in 

determining the time to reach a critical temperature (at about head height) in the neighbouring 

rooms where there are no exterior doorways to use for exit.  

 

 

25.5.2 STEP 1: CREATING THE GEOMETRY AND SCENARIO 

 

Run the SMARTFIRE case specification tool. Once the graphical user interface has opened, 

select the [Region] menu panel and set the size of the geometry region as X=17.2m, Y=4.0m 

and Z=9.0m. Having correctly sized the simulation region, it is sensible to name the case by 

selecting the [File] and [Save As] option. This allows the creation of the SMARTFIRE work 

directory for this case. All of the model files and result files, for the current case, will reside 

in this folder. For example if the case is named "t_4" then the file "t_4.smf" will be saved in 

the "smartfire\work\t_4" directory. This folder will contain all of the geometric and physical 

properties for the specification of the case and, later it will contain all of the simulation and 

result files for this scenario. 

 

The simulation scenario uses Heat, Flow and the Radiation model with the Six-Flux model 

activated. The Default Wall Emissivity is set to 0.8. The Combustion, Smoke and Enhanced 

Body Force models are NOT activated. The simulation is run in Transient mode with a Time 

Step Size of 2.0 seconds with 50 Sweeps per time step. The Number of time steps is set to 

150 (i.e. simulating 300 seconds or 5 minutes). The Convergence tolerance is used as the 

default 0.001. The physical properties are set as follows. The Default wall thickness is 0.2m, 

the Ambient temperature is set to 288.75K, the External pressure is 101325.0 Pa and the 

Material inside the region is "Standard_Air". 

 

Select the [Scenario] option from the main menu bar and select [Problem type] to access the 

Problem type for this scenario. The Problem type options window should appear as follows:  
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Figure 25-37 Problem type options window. 

 

In order to create the objects that make the walls, windows and the fire for the simulation 

case, select the [Object] notebook tab. This will allow you to add objects to the current region 

or to change the properties of any objects already created. You will need to create, accurately 

position and correctly size the following list of objects by selecting [New]. The objects that 

need to be created are as listed below. It should be noted that some considerable time could 

be saved when creating a large number of objects by using the [Clone] feature. It is possible 

to create the first Wall Partition and set the correct material type, and then to clone the object 

and move and resize the "cloned" partition to the position and size of the next Wall Partition. 

This saves the time associated with setting the material type for the "cloned" object and it is 

often the case that one or more of the position and/or size parameters will be the same as the 

previous object. Similarly the Windows can be cloned and then suitably sized and positioned 

further along the wall. When an object is cloned the clone is created in the same position and 

with the same size as the "parent" object. Both the cloned and parent objects will be displayed 

with dotted edges (in wire frame view mode) to indicate that they are "overlapping" objects. 

 

The following objects define the geometry of the multiple room simulation scenario. 

 

Window (in the large room): 

VENT at (x=3.3, y=1.0) on the low-z wall. Size is (dx=1.5, dy=2.0). 

 

Window (in the long thin room): 

VENT at (x=6.7, y=1.0) on the low-z wall. Size is (dx=1.0, dy=2.0). 

 

Window (in the long thin room): 
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VENT at (x=11.1, y=1.0) on the low-z wall. Size is (dx=1.0, dy=2.0). 

 

Doorway (in the long thin room): 

VENT at (x=14.0, y=0.0) on the low-z wall. Size is (dx=1.2, dy=2.5). 

 

Partition Wall (wall of large room):  

OBSTACLE at (x=6.0, y=0.0, z=0.0). Size is (dx=0.2, dy=4.0, dz=9.0). Material=Brick. 

 

Doorway (in wall of large room): 

PORTAL at (x=6.0, y=0.0, z=3.2). Size is (dx=0.2, dy = 2.5, dz=2.5). 

 

Partition Wall (wall of long thin room):  

OBSTACLE at (x=6.2, y=0.0, z=3.0). Size is (dx=11.0, dy=4.0, dz=0.2). Material=Brick. 

 

Doorway (in wall of large room): 

PORTAL at (x=6.2, y=0.0, z=3.0). Size is (dx=2.0, dy = 2.5, dz=0.2). 

 

Partition Wall (wall of little room nearest the fire): 

OBSTACLE at (x=8.2, y=0.0, z=5.9). Size is (dx=0.2, dy=4.0, dz=3.1). Material=Brick. 

 

Doorway (doorway of little room nearest the fire): 

PORTAL at (x = 8.2, y=0.0, z=8.0). Size is (dx=0.2, dy=2.5, dz=1.0) 

 

Partition Wall (corridor edge wall for both little rooms): 

OBSTACLE at (x=8.2, y=0.0, z=5.7). Size is (dx=9.0, dy=4.0, dz=0.2). Material=Brick. 

Doorway (farthest from fire) 

PORTAL at (x =16.0, y = 0.0, z=5.7). Size is (dx=1.2, dy=2.5, dz=0.2). 

 

Partition Wall (wall between the little rooms): 

OBSTACLE at (x=12.6, y=0.0, z=5.9). Size is (dx=0.2, dy=4.0, dz=3.1). Material=Brick. 

 

Fire : 

SIMPLE FIRE at (x=6.7, y=0.0, z=7.0). Size is (dx=1.0, dy=1.0, dz=1.0). Expert Heat 

Release curve with A=150, B=0.0, C=0.1285, D=0.0 and E=0.0 with Start_time=0.0s and 

End_time=120.0s. Shows maximum heat release as 2000kW at T=120s. 

 

Monitor Graph : 

MONITOR LINE at (x=0.0, y=1.8, z=8.5). Size is (dx=17.2, dy=0.2, dz=0.2). Direction=X-

Direction with X axis variable=X_COORD and Y axis variable=TEMPERATURE. 

 

The OBSTACLE objects are defined as follows: 
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Figure 25-38 Obstacle properties used in the simulation scenario. 

 

The SIMPLE FIRE object is defined as follows: 

 

 

Figure 25-39 Simple Fire properties window showing the fire settings. 

 

The MONITOR LINE object is defined as follows: 
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Figure 25-40 Monitor Line properties window showing the settings. 

 

Once all of the geometry objects have been created, positioned and sized correctly the 

geometry displays should be as follows: 
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Figure 25-41 Rendered Perspective 3D geometry showing windows, walls, fire and 

monitor line. 

 

 

Figure 25-42 Geometry shown in wire frame view mode. 
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Figure 25-43 Plan view (XZ) display of the geometry. 

 

 

Figure 25-44 Side view (XY) display showing the geometry. 
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Figure 25-45 End view (YZ) display showing the geometry. 

 

There is one last issue to handle before the geometry can be meshed. The default meshing 

controls assume that every simulation case should have a sufficiently refined mesh to allow 

reasonable results to be obtained. This is a reasonable assumption for normal usage, but for 

the purposes of this tutorial it is recommended that a few of the meshing rules are deactivated 

to allow a courser mesh to be created. Access to the meshing controls and parameters can be 

found in the main menu under [Scenario] and [Meshing Controls]. The Meshing Control 

Parameters window appears as follows: 
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Figure 25-46 Meshing Control Parameters window. 

 

In order to allow the meshing system to create a more even course mesh it is advisable to 

disable the creation of thin layers around objects. The check boxes that must be unchecked 

are the [Use near wall layer], the [Use near obstacle layer] and the [Use near fire layer]. All 

of the other options can be left to the default settings. Do not press the [Save Current] button 

as this will save the current meshing parameters into a support file to be used whenever the 

Smartfire Environment is run. Simply select [OK] to proceed with the modified control 

settings. 

 

25.5.3 STEP 2: CREATING A MESH FOR THE SIMULATION 

 

Once you are satisfied with the geometry and physics handling of the case, you need to run 

the mesh creation system. To run the automated meshing tool from the main menu, choose 

the [Run] option and the select [Create Mesh]. This will open the mesh creation tool user 

interface. The automated meshing tool will first determine if the current geometry already has 

an existing mesh previously created. If one is available then the user will be given the option 

to load the existing mesh or to create a new one. It is assumed that no existing mesh is 

available or that the user will create a new mesh. 

 

The meshing tool will check for any geometry or modelling issues that might need to be 

resolved. If there are any problems then the system will ask the user to select an appropriate 

resolving action. For example the system WILL detect overlapping objects in the geometry 

that has been specified above (the walls and the monitor line object overlap since the monitor 

line extends from end to end of the region passing through some of the walls and the portals 
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overlap with the obstacles) but this overlap is harmless and will not impede the meshing and 

hence, the user can choose to ignore the overlaps for this case. 

 

The system will also analyse the requirements for extended regions. Basically an extended 

region will be needed outside of any VENT object (the doors and windows in the low XY 

wall of the geometry). If there are multiple vents on a surface then only one extended region 

will be required for the whole of the surface. The system presents a selection window that 

shows the necessary and recommended extended region creation. The system may choose to 

recommend that some adjacent surfaces also have an extended region when the vents are in 

close proximity to the adjacent surfaces. This is necessary because the free surface patch 

applied to the outside of the extended region is an idealised boundary condition that actually 

applies a long way away from the vent. In practice we tolerate a separation in the range of 4 

to 10 metres as this gives acceptable simulation behaviour. In the current scenario there is 

only one required extended region and the user should accept this choice without creating any 

additional extended regions. The Additional Extended Regions window appears as follows: 

 

 

Figure 25-47 Window showing the options for creating extended regions. 

 

Once all of the geometry and modelling issues have been resolved, the meshing system will 

analyse the geometry and present the Cell budget window. This has the automated meshing 

system's recommended cell budget with individual user-selectable cell budgets for each of the 

co-ordinate directions. It is recommended that the case is first meshed as a course mesh 

(usually a good option for checking that a case has been correctly specified and that all of the 

physics and numerics behave as expected). Unfortunately, for the course mesh, the meshing 

system struggles to create a very even mesh. The Cell Budget window appears as follows: 
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Figure 25-48 Cell budget for meshing. 

 

The first attempt at meshing using a course mesh appears as follows: 
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Figure 25-49 First attempt course mesh from the automated meshing system. 

 

This mesh would NOT be acceptable for a production run, however it would allow a quick 

test run to be performed in order to check that the geometry is correct and that all events (for 

a transient simulation with transitional behaviour) work as required. In order to create a 

suitably even and more refined mesh, the number of cells in some of the mesh slices will 

need to be increased. This could be performed manually by selecting on the mesh windows to 

highlight a slice for refinement and then using the number of cells spin box to change the 

number of cells in that slice. Alternatively, the button labelled [Refine+] can be used to 

iteratively insert cells into the geometry slices until the mesh quality is deemed to be 

acceptable (or the cell budget is too large to run on the target hardware). Even a mesh that has 

been automatically refined might have areas that can be further improved so it is important to 

visually inspect the mesh to see if any further modifications are necessary. 

 

It should be noted that there is no “absolutely correct mesh” for any simulation and, with 

experience, the user will eventually develop knowledge of when and where cells need to be 

refined. Generally the following points should be considered when refining a mesh. 

 

(1) The fire will be generating a highly buoyant plume that may lean over as air is entrained 

or channelled around obstacles. It is good practice to provide additional cells in the vicinity of 

the fire to give the plume as much freedom as possible. 

 

(2) Vents are likely to develop higher speed, channelled flows and will consequently benefit 

from having as many cells as possible across their height and width. 

 

(3) Where a buoyant plume impacts a ceiling (or a ceiling jet impacts a wall) there should be 

as many cells as possible to allow for plume (or jet) rotation. 
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(4) It is not a good idea to have largely dissimilar sizes between adjacent mesh cells. 

 

(5) It is not a good idea to have very squashed (or elongated) mesh cells.   

 

After automatic refinement (using [Refine+]), the mesh should appear as follows: 

 

 

Figure 25-50 Refined mesh. 

 

Note that the cell budget has increased dramatically from the first course meshing attempt, 

but that the refined mesh is much more evenly spaced in all three coordinate directions. The 

mesh is now ready and can be saved for simulation. Pressing the [Accept] button will allow 

the mesh and scenario specification to be saved as a set of specification files for the CFD 

Engine to read. Pressing the [Accept] button will also cause the automated meshing tool to 

close and control will then return to the SMARTFIRE Case Specification Environment. 

 

25.5.4 STEP 3: RUNNING THE CFD ENGINE 

 

The final stage involves performing the numerical simulation itself using the CFD engine 

component of SMARTFIRE. To run the CFD engine select on the main menu item [Run] and 

the [Run CFD Engine] option. This will launch the numerical CFD engine that will 

automatically load the case specification and mesh that you have just created. You may have 

to be a little patient as this stage involves a considerable amount of file parsing, memory 

allocation and initialisation. Eventually the user interface for the CFD engine will appear 

completely. It should be noted that if you are using a fairly low resolution display (under 

1024 x 768 pixels) then the CFD engine use-interface may display itself with more compact 

windows and a slightly different layout (e.g. with more of the windows initially closed) in 

order to create a usable display. 
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Once the CFD Engine has loaded the data and performed all of the require initialisations then 

the User Interface will be displayed with the un-processed view of the simulation case. The 

initial CFD Engine display will appear as follows: 

 

 

Figure 25-51 SMARTFIRE CFD Engine user interface at start up. 

 

The Case Specification Environment will have pre-selected a default view plane for the 

visualisation (typically at the halfway layer of cells in the X-direction). Unfortunately this 

view plane might not be a particularly interesting one to display, so it is worth selecting a 

good plane to view throughout the simulation. In this case we have not kept any information 

about what would be a good plane to select but we can use the visual configuration window 

to "find" a suitable plane. If we press the [Visual] button then the Visual Configuration 

Window will open and we can use it to investigate the arrangement of the objects so that a 

more interesting slice plane can be found. By selecting the lowest Y slice, we can see where 

the fire is located in the Visual Display window. 

 

It is then a simple matter of re-entering the Visual Configuration Window and selecting the 

planar slice that will give a more meaningful display of what is occurring in the vicinity of 

the fire. 
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Figure 25-52 Visual Configuration selecting the lowest Y-layer of cells to view. 

 

  
Figure 25-53 Visualisation of the lowest Y-slice of cells showing the fire location. 
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After selecting the X=22 slice (check this is through the centre of the fire as it will depend on 

the mesh that was used) the following Visual Display will appear on the User Interface. 

 

 

Figure 25-54 SMARTFIRE User Interface after selection of a more interesting visual 

slice plane through the fire. 

 

It should be noted that the Visual Configuration Window could also be used to change the 

features that are displayed in the Visualizer. In the image above the [Contour Fill] option of 

"TEMPERATURE" has been activated because this gives a clearer representation of the 

temperatures in the fire plane, especially when using vectors of velocity in the same display.  

 

Before starting the simulation, it is worth considering the forms and frequency of data capture 

from the simulation. If the user simply wishes to see what conditions are like at a particular 

time then the simulation can be run until that required simulation time ha been reached. In 

our scenario we are not sure what time the conditions will occur so we need to save sufficient 

data to allow us to analyse the time at which certain conditions were experienced. The user 

should open the [Configure] menu from the main menu and select [Data Capture]. This 

presents the Data Capture Configuration menu, where the frequency and nature of the data 

that will be saved during (and at the end of) the simulation, can be configured. In this 

simulation it is recommended that the user save the results, graphs and visuals at the end of 

every time step. This is configured by ticking the appropriate check boxes in the "Automatic 

Transient Outputs" section of the menu. 
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Figure 25-55 Data Capture Configuration menu. 

 

Now that everything has been configured it is possible to start the processing of the 

simulation scenario. 

 

In order to start the numerical simulation, you will need to press the [Run] button, marked 

with a GREEN (GO) icon. This will start the simulation process. To halt the simulation at any 

time, press the [Halt] button marked by a RED (STOP) icon. You can also terminate the 

simulation at any point by pressing the [Exit] button (showing a little door icon). There are a 

number of extra buttons and other controls that allow experts to intimately control the 

configuration of the solution process. However, non-experts are not recommended to make 

any changes to the control settings unless they are recommended in the user guide. 

 

The graphical windows of the user interface present various views of the data and the status 

of the simulation during the simulation process. The things to look for are: 

 

1) The residual graphs that are indicators of the convergence of the solved and calculated 

variables of the numerical simulation process (Top right). 

 

2) The monitor values and variable residuals (current solution error states) of various 

important variables are shown in the status window (Bottom left). 

 

3) The emerging vector flow and temperature contour patterns for the particular selected 

slice of the room in the Visualizer window (Bottom right). SMARTFIRE is now able 

to maintain multiple visualization windows, each containing completely independent 

view and display selections. 

 

4) The data ranges for each variable displayed in the status window (Bottom left). 

 

5) The control window has progress bars in its bottom right corner (below the 

visualisation buttons). These bars indicate solution progress. The upper bar is filled 

once every sweep whilst the lower bar is filled once for the whole configured 
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simulation (Top left). 

 

6) The status window has displays indicating the sweep number and time step number 

(only for transient simulations) to indicate the current stage of processing (Bottom 

left).  

 

7) The status window has estimates for the CPU time taken and remaining. These are 

only estimates but can give a reasonable approximation of the expected duration of a 

simulation (Bottom left). 

 

8) A key feature of SMARTFIRE is the access to save a bookmark and restart from 

saved bookmarks at any time. The control button labelled [Mark] will drop a 

bookmark of the current stage of the solution into a database for this case. The button 

labelled [Restart] allows a previous bookmark state to be loaded as if subsequent 

processing had not happened. This can be invaluable for problematic simulations that 

need expert solution control or simply for saving data for future examination (Top 

left). 

 

9) There is a control button labelled [Plots] that allows you to define line graphs through 

the data. These plot line graphs are updated as the solution progresses (Top left). 

There will be a single Plot window available to view that represents the monitor line 

that was created in the geometry specification. 

 

 

Figure 25-56 SMARTFIRE User Interface showing the end stage of the simulation. 
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25.5.5 STEP 4: INTERPRETING RESULTS FROM SMARTFIRE 

 

If the simulation case has been run with a course mesh, it means that we cannot totally rely 

on the results for any safety critical assessment of the modelled scenario. Also we might not 

have not been very exacting about ensuring complete convergence (although a brief 

examination of the end of time step convergence history - the Time Step Residual Graph - 

indicates that most of the time steps ended at a reasonable state of convergence for this 

simulation). However we can use the results or data from the simulation to give a better 

understanding of the behaviour that we are likely to meet from this scenario. 

 

The purpose of the simulation was to get a rough indication of the times before the rooms, 

neighbouring the fire, experienced conditions that are threatening to life. We are only 

considering the effect of elevated temperatures in the modelled scenario and effects such as 

smoke concentration, thermal radiation or the toxic gas concentration, are not considered. 

Again we can obtain a rough understanding of the fire effects by considering a typical 

harmful exposure time for a normal person to be approximately 1 minute at an air 

temperature of 180
o
C. Remember that the SMARTFIRE CFD Engine is calculating 

temperatures in Kelvin. If we assume that, for safety considerations, reaching a critical 

temperature of 120
o
C indicates the onset of dangerous - to human life - conditions. We can 

check through the plot graph data for the monitor line to determine at what time during the 

simulation each room experienced temperatures of 120
o
C (i.e. 393K) or more in the vicinity 

of the monitor line. 

 

Figure 25-57 Graph of monitored temperatures in Large Room at t=118s. 

 

Simple examination of the monitor line plot graph at the end of the simulation indicates that 

all of the monitored rooms are experiencing temperatures in excess of 500K (i.e. 227
o
C). 

 

Temperatures along monitor line in Large Room at t=118s
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Further analysis of the saved graph plot data files reveals the following times to reach the 

critical temperature. 

 

Monitored Room Time until first monitored 

cell above Tcritical 

Time until all monitored 

cells above Tcritical 

Large Room (with 

single window) 

118s 126s 

Small Room nearest to 

fire 

78s 106s 

Small Room furthest 

from fire 

104s 116s 

Table 25-58 Table of times to detect critical temperatures in monitored rooms. 

  

At face value this suggests that (given our assessment of some critical temperature detected at 

a particular location as representative of the onset of dangerous conditions) the Large Room 

has approximately 2 minutes until the onset of dangerous conditions whilst the small room 

experiences dangerous conditions a little after 1 minute. 

 

It should be noted that this tutorial is not intended to give an exacting study into the fire 

safety considerations pertaining to a single fire modelling scenario but, rather, give an 

indication of the nature of possible simulations and the types of questions that can be asked of 

the simulation results. 

 

25.5.6 STEP 5: EXITING THE CFD ENGINE 

 

To exit the code, you first need to exit the CFD engine interface using the [Exit] button. On 

normal termination, the SMARTFIRE CFD engine will save a number of files that can be 

used for further visual post-processing (abnormal termination will not save any files and is 

encountered when the main window [X] button is pressed. Finally the CFD engine user 

interface will close and you will get back to the original geometry set-up tool. If you want to 

save any changes you have made to the fire modelling case, select the [File] item and then the 

[Save] option from the main menu. 

 

It is interesting to note that the case directory (for a completed simulation) contains many 

files that have been created during this exercise. Some of these files can be used for graphical 

post-processing and for re-starting this simulation from the stage when it was exited. Also 

there may be data capture files saved during your simulation.  

 

This is the end of tutorial 4. 
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25.6 TUTORIAL 5 

 

 

25.6.1 OVERVIEW 

 

 

This tutorial extends the scenario used in Tutorial 4 to add a large, powerful, ducted extractor 

fan to the small room (nearest the fire). All of the other geometry and scenario specifications 

are identical to those in Tutorial 4 except for the changes to the geometry objects and the 

meshing that are needed for the inclusion of the fan. The plan view of the geometry is as 

follows: 

 

  

Figure 25-59 Plan view drawing showing the room layout geometry. 

 

As with the Tutorial 4 scenario, certain assumptions have been made to simplify the 

specification as follows: 

 The rooms are all assumed to be open during the fire simulation so all of the doorways 

and windows are fully open for all of the simulation. 

 The doors on the end of the corridor are assumed closed throughout the simulation and 

they are of sufficient strength that the fire will not affect their structural integrity. There 

are actually windows present on the large outer wall of the largest room but these are 

assumed closed (and are hence not modelled) during the simulation (in practice this cuts 

down the requirement for an additional extended region and hence makes the simulation 

run faster). It should be noted that if the “closed” windows experience conditions that 

would make them break, then they would need to be modelled with the possibility of 

opening. Otherwise, imposing the always closed condition on the windows would create 

a false set of conditions for the simulation. 
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 Small air leaks around closed doors or windows are ignored and the heat transfer 

through the walls is considered to be negligible compared to heat transfer due to other 

processes, in the duration of the simulation. 

 The corridor is assumed to have no combustible materials, which can support fire 

spread or secondary ignition.  

 

The geometry of this case could be constructed from scratch but it is recommended that the 

user actually loads the SMARTFIRE model file created for Tutorial 4, saves it as a new case 

and then adds the extra objects required for the fan. 

 

Again the fire is assumed to be a cleaning trolley fire at one end of the corridor. The fire 

reaches a peak heat release rate of 2MW in two minutes. Since the fire is in the corridor and 

will prevent conventional means of egress from the building, we are actually interested in 

determining the times to reach a critical temperature (at about head height) in the 

neighbouring rooms where there are no exterior doorways to use for exit. 

 

The Fan (actually a SIMPLE FAN object) is assumed to be a smoke extraction system that is 

activated 20 seconds after the fire has been detected. For the sake of simplicity, it is assumed 

that the detection system is near to the fire source (in the corridor) and that the Fan is 

activated 20 seconds into the simulation. The Fan system is assumed to be sufficiently robust 

so that it will allow the extraction of very hot gasses for the duration of the simulation. This is 

not an unreasonable assumption if the fan motor and blades were well removed from the fire 

source by ducting and the fan has been designed with this task in mind. It is also assumed that 

all the ductwork for the fan is also sufficiently robust to maintain its integrity for the duration 

of the simulation. It should be noted that, in practice, the details of the failure characteristics 

of the ductwork and the fan unit would need to be taken into consideration and compared 

with the likely conditions experienced in the simulation. 

 

25.6.2 STEP 1: LOADING THE BASE CASE AND RENAMING 

 

Run the SMARTFIRE case specification tool. Once the graphical interface has opened, use 

[File] and [Open] to open the file loading menu. Use the file loading dialog window to 

browse to the folder containing the tutorial case from Tutorial 4 (probably called “tutorial_4” 

or "t_4"), typically found in the "smartfire\work" folder. Select the SMARTFIRE model file 

for this case (named "t_4.smf" - if using the naming convention suggested in Tutorial 4), and 

select the [Open] button. The base case from Tutorial 4 will be loaded and the default 3D 

wire frame view of the case will be displayed. 

 

In order to prevent any subsequent geometry or scenario modifications from being 

accidentally written back into the Tutorial 4 case, it is recommended that the case is 

immediately renamed by selecting the [File] and [Save As] option. Use the file save dialog to 

browse back up to the "smartfire\work" folder - since you will currently be INSIDE the "t_4" 

folder, and enter the name "t_5" in the File name field and select the [Save] button. The case 

will be renamed and a newly named "t_5.smf" model file will be saved in a new "t_5" folder. 

 

Now you can proceed to add the objects needed to create the simple fan. 
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Figure 25-60 Specification tool showing the renamed case from Tutorial 4. 

 

25.6.3 STEP 2: ADDING A DUCTED FAN TO THE SCENARIO 

 

The actual SIMPLE FAN object is a generic fan source object that can be used to create 

forced ventilation ranging from ducted extractor fans to simple (unidirectional) desk fans. 

Constructing a ducted extract fan is a little more complex than simply adding the generic 

SIMPLE FAN object since there are additional considerations to be made in order to get the 

desired flow behaviour. 

 

The SIMPLE FAN object needs some surrounding ducting to make it a "ducted" extractor 

fan. Otherwise flow would be able to enter (or leave) the fan unit from the sides and the fan 

would behave more like a simple desktop fan. This ducting could be constructed from four 

THIN PLATE objects or from four OBSTACLE objects depending on the best geometric 

representation of the actual ducting. 

 

The fan unit is extracting through a solid wall but we are not actually concerned with the air 

once it has left the region of simulation. In order to achieve this effect it is necessary to place 

an OUTLET patch on the wall surface within the fan duct. This outlet patch provides a 

surface where all of the air extracted from the region can be dumped. 

 

The final consideration is that the SIMPLE FAN object needs to spread the momentum forces 

over a layer of cells on either side of the SIMPLE FAN object itself. For this reason there 

must be at least a one cell air gap between the SIMPLE FAN object and the OUTLET patch. 

The following diagram should help to clarify the construction of the ducted extractor fan. 
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Figure 25-61 Components used for the construction of a ducted fan using a SIMPLE 

FAN object, an OUTLET object and four THIN PLATE objects. 

 

The following objects define the ducted fan unit and should be added with the specified 

positions and sizes. 

 

Outlet through the wall (in the small room nearest the fire): 

OUTLET at (x=10.0, y=2.5) on the high-z wall. Size is (dx=0.8, dy=0.8). The OUTLET 

Pressure should be set to 0.0 Pa and the Temperature set to ambient (i.e. 288.15 K). 

 

Fan blower (in the small room nearest the fire): 

SIMPLE FAN at (x=10.0, y=2.5, z=8.6) on the low-z wall. Size is (dx=0.8, dy=0.8, dz=0.2). 

The Simple Fan blowing direction should be set to Z+, which is the outward direction for the 

high-z surface of the region - where the fan is located. The Fan velocity should be set to 5 m/s 

and the coefficient value left at the default 1000.0. The Start time for the fan should be set in 

the activation section so that the Fan will be “Active from start (added at start time)” with 

20.0 seconds as the fan start time.  

 

 

The SIMPLE FAN properties window should appear as follows: 
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Figure 25-62 Simple Fan properties window. 

 

Fan duct, low-x edge (in the small room nearest the fire): 

THIN PLATE at (x=10.0, y=2.5, z=8.6) in the x-direction. Size is (dy=0.8, dz=0.4). 

 

Fan duct, high-x edge (in the small room nearest the fire): 

THIN PLATE at (x=10.8, y=2.5, z=8.6) in the x-direction. Size is (dy=0.8, dz=0.4). 

 

Fan duct, low-y edge (in the small room nearest the fire):  

THIN PLATE at (x=10.0, y=2.5, z=8.6) in the y-direction. Size is (dx=0.8, dz=0.4). 

 

Fan duct, high-y edge (in the small room nearest the fire): 

THIN PLATE at (x=10.0, y=3.3, z=8.6) in the y-direction. Size is (dx=0.8, dz=0.4). 

 

The following images may help with the positioning and orientation of the objects used to 

create the fan unit. 
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Figure 25-63 Close up wire frame view of the Fan unit. 

 

  
Figure 25-64 Exploded view (with components separated) of the Fan unit. Note that 

there is an air gap needed between the SIMPLE FAN object and the OUTLET object. 
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All of the other settings for the scenario are the same as for Tutorial 4, except that the 

[Enhanced Body Force] needs to be activated from the Problem Type window. It should be 

noted that the SMARTFIRE Case Specification Environment will detect that SIMPLE FAN 

and/or FAN objects have been used and will inform the user that the Enhanced Body Force 

must be activated when using fans. 

 

25.6.4 STEP 3: CREATING A MESH FOR THE SIMULATION 

 

Once you are satisfied with the geometry and physics handling of the case you need to run 

the mesh creation system. To run the automated meshing tool from the main menu, choose 

the [Run] option and the select [Create Mesh]. This will open the mesh creation tool user 

interface. The automated meshing tool will first determine if the current geometry already has 

an existing mesh previously created. If one is available then the user will be given the option 

to load the existing mesh or to create a new one. It is assumed that no existing mesh is 

available or that the user will create a new mesh. 

 

It should be noted that the mesh created for this scenario, whilst similar to that created for 

Tutorial 4, will have differences in the number (and usage) of slices and the requirements for 

meshing will be different in the vicinity of the Fan. The addition of even a few extra objects 

can radically affect the overall mesh cell budget, since each object brings an extra 2 edges in 

each direction. 

 

Once meshing is initiated, the meshing tool will check for any geometry or modelling issues 

that might need to be resolved. If there are any problems then the system will ask the user to 

select an appropriate resolving action. For example the system WILL detect overlapping 

objects in the geometry that has been specified above (the walls and the monitor line object 

overlap since the monitor line extends from end to end of the region passing through some of 

the walls) but this overlap is harmless and will not impede the meshing and hence, the user 

can choose to ignore the overlaps for this case. 

 

The system will also analyse the requirements for extended regions. Basically an extended 

region will be needed outside of any VENT object (the doors and windows in the low XY 

wall of the geometry). If there are multiple vents on a surface then only one extended region 

will be required for the whole of the surface. The system presents a selection window that 

shows the necessary and recommended extended region creation. The system may choose to 

recommend that some adjacent surfaces also have an extended region when the vents are in 

close proximity to the adjacent surfaces. This is necessary because the free surface patch 

applied to the outside of the extended region is an idealised boundary condition that actually 

applies a long way away from the vent. In practice we tolerate a separation in the range of 4 

to 10 metres as this gives acceptable simulation behaviour. In the current scenario there is 

only one required extended region and the user should accept this choice without creating any 

additional extended regions. The Additional Extended Regions window appears as follows: 
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Figure 25-65 Window showing the options for creating extended regions. 

 

Once all of the geometry and modelling issues have been resolved, the meshing system will 

analyse the geometry and present a Cell budget window. This has the automated meshing 

system's recommended cell budget with individual user-selectable cell budgets for each of the 

co-ordinate directions. It is recommended that this case be meshed as a unit block mesh with 

the refine option. This creates a reasonable mesh to run this case although it might not be 

appropriate for a production run, where accurate results are needed. The Cell Budget window 

appears as follows: 
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Figure 25-66 Cell budget for meshing. 

 

This attempt at meshing using a refined mesh, appears as follows: 
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Figure 25-67 Mesh from the automated meshing system. 

 

This mesh would be adequate for a tutorial run to check that the scenario is working as 

expected, however a production run – where the results need to be accurate – would need a 

more even and higher quality mesh. It should be noted that it is possible to manually refine 

the mesh using the "slice" selection combo box and slice number spin box to highlight a slice 

for refinement or by pointing at the required slice in the display windows and selecting (with 

the mouse pointer and button) to make the current slice active (highlighted with grey=internal 

region or green=external region shading). 

 

The user should always visually check the mesh after it has been refined to ensure that there 

are no issues caused by irregular slices or having a restricted cell budget. It should be noted 

that there is no absolutely correct mesh for any simulation and, with experience, the user will 

eventually develop knowledge of when and where cells need to be refined. Generally the 

following points should be considered when refining a mesh. 

 

(1) The fire will be generating a highly buoyant plume that may lean over as air is entrained 

or channelled around obstacles. It is good practice to provide additional cells in the vicinity of 

the fire to give the plume as much freedom as possible. 

 

(2) Vents are likely to have higher speed channelled flows and will consequently benefit from 

having as many cells as possible across their height and width. 

 

(3) Where a buoyant plume impacts a ceiling (or wall) there should be as many cells as 

possible to allow for plume rotation into ceiling jets. 

 

(4) It is not a good idea to have largely dissimilar sizes between adjacent mesh cells. 
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(5) It is not a good idea to have very squashed (or elongated) mesh cells. 

 

(6) The flows in the vicinity of a Fan are likely to be complex and quite strong. It is advisable 

to have reasonable refinement of cells between openings (e.g. the doorway) and the Fan.   

 

The mesh is ready and can be saved for simulation. Pressing the [Accept] button will allow 

the mesh and scenario specification to be saved as a set of specification files for the CFD 

Engine to read. Pressing the [Accept] button will also cause the automated meshing tool to 

close and control will then return to the SMARTFIRE Case Specification Environment. 

 

25.6.5 STEP 4: RUNING THE CFD ENGINE 

 

The final stage involves performing the numerical simulation itself using the CFD engine 

component of SMARTFIRE. To run the CFD engine select on the main menu item [Run] and 

the [Run CFD Engine] option. This will launch the numerical CFD engine that will 

automatically load the case specification and mesh that you have just created. You may have 

to be a little patient as this stage involves a considerable amount of file parsing, memory 

allocation and initialisation. Eventually the user interface for the CFD engine will appear 

completely. It should be noted that if you are using a fairly low resolution display then the 

CFD engine use-interface may display itself with more compact windows and a slightly 

different layout (e.g. with more of the windows initially closed) in order to create a usable 

display. 

 

Once the CFD Engine has loaded the data and performed all of the required initialisations, 

then the User Interface will be displayed with the un-processed view of the simulation case. 

The initial CFD Engine display will appear as follows: 
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Figure 25-68 SMARTFIRE CFD Engine user interface at start up. 

 

The Case Specification Environment will have selected a default view plane for the 

visualisation (typically at the halfway layer of cells in the X-direction). Unfortunately this 

view plane might not be a particularly interesting one to display, so it is worth selecting a 

good plane to view throughout the simulation. In this case we have not kept any information 

about what would be a good plane to select but we can use the visual configuration window 

to "find" a suitable plane. If we press the [Visual] button then the Visual Configuration 

Window will open and we can use it to investigate the arrangement of the objects so that a 

more interesting slice plane can be found. By selecting the lowest Y slice, we can see where 

the fire is located in the Visual Display window. 

 

It is then a simple matter of re-entering the Visual Configuration Window and selecting the 

planar slice that will give a more meaningful display of what is occurring in the vicinity of 

the fire. 
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Figure 25-69 Visual Configuration selecting the lowest Y-layer of cells to view. 
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Figure 25-70 Visualisation of the lowest Y-slice of cells showing the fire location. 

 

In order to keep track of both the Fire plane and the Fan plane, two visualizations are 

configured using the [Visual Index] spin box in the Visual Configuration Window and the 

[Active] check box. Visual [1] depicts the X=32 slice (the user should check that this is 

through the centre of the fire) and Visual [2] depicts the X=44 slice (for this mesh the cut 

plane is through the centre of the Fan). Using these two visualizations and manually 

arranging the Visualizer windows so that both are visible on screen, makes the User Interface 

appear as follows: 
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Figure 25-71 SMARTFIRE showing visuals of the fire plane and the fan plane. 

 

It should be noted that the Visual Configuration Window could also be used to change the 

features that are displayed in the Visualizers. In the image above the [Contour Fill] option of 

"TEMPERATURE" has been activated because this gives a clearer representation of the 

temperatures in the fire plane, especially when using vectors of velocity in the same display.  

 

Before starting the simulation it is worth considering the forms and frequency of data capture 

from the simulation. If the user merely wishes to see what conditions are like at a particular 

time then it is simple to run the simulation until that required simulation time is reached. In 

our scenario we are not sure what time the conditions will occur so we need to save sufficient 

data to allow us to analyse the time at which certain conditions were experienced. The user 

should open the [Configure] menu from the main menu and select [Data Capture]. This 

presents the Data Capture Configuration menu, where the frequency and nature of the data 

that will be saved during (and at the end of) the simulation, can be configured. In this 

simulation it is recommended that the user save the results, graphs and visuals at the end of 

every time step. This is configured by ticking the appropriate check boxes, and setting the 

times between saves, in the "Automatic Transient Outputs" section of the menu. 
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Figure 25-72 Data Capture Configuration menu. 

 

Now that everything has been configured, it is possible to start the processing of the 

simulation scenario. 

 

In order to start the numerical simulation, you will need to press the [Run] button, marked 

with a GREEN (GO) icon. This will start the simulation process. To halt the simulation at any 

time, press the [Halt] button marked by a RED (STOP) icon. You can also terminate the 

simulation at any point by pressing the [Exit] button (showing a little door icon). There are a 

number of extra buttons and other controls that allow experts to intimately control the 

configuration of the solution process. However, non-experts are not recommended to make 

any changes to the control settings unless they are recommended in the user guide. 

 

The graphical windows of the user interface present various views of the data and the status 

of the simulation during the simulation process. The things to look for are: 

 

1) The residual graphs that are indicators of the convergence of the solved and calculated 

variables of the numerical simulation process (Top right). 

 

2) The monitor values and variable residuals (current solution error states) of various 

important variables are shown in the status window (Bottom left). 

 

3) The emerging vector flow and temperature contour patterns for the particular selected 

slice of the room in the Visualizer window (Bottom right). SMARTFIRE is now able 

to maintain multiple visualization windows, each containing completely independent 

view and display selections. 

 

4) The data ranges for each variable displayed in the status window (Bottom left). 

 

5) The control window has progress bars in its bottom right corner (below the 

visualisation buttons). These bars indicate solution progress. The upper bar is filled 

once every sweep whilst the lower bar is filled once for the whole simulation. 
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6) The status window has displays indicating the sweep number and time step number 

(only for transient simulations) indicating the current stage of processing.  

 

7) The status window has estimates for the CPU time taken and remaining. These are 

only estimates but can give a reasonable approximation of the expected duration of a 

simulation (Bottom left). 

 

8) A key feature of SMARTFIRE is the access to save a bookmark and restart from 

saved bookmarks at any time. The control button labelled [Mark] will drop a 

bookmark of the current stage of the solution into a database for this case. The button 

labelled [Restart] allows a previous bookmark state to be loaded as if subsequent 

processing had not happened. This can be invaluable for problematic simulations that 

need expert solution control or simply for saving data for future examination.  

 

9) There is a control button labelled [Plots] that allows you to define line graphs through 

the data. These plot line graphs are updated as the solution progresses (Top left). 

There will be a single Plot window available to view that represents the monitor line 

that was created in the geometry specification. 

 

 

 

Figure 25-73 SMARTFIRE User Interface showing the end stage of the simulation, 

showing the fire plane visual and the monitored temperature plot graph. 

 

 



SMARTFIRE TUTORIAL GUIDE 

 

 

 25-74 

25.6.6 STEP 5: INTERPRETING RESULTS FROM SMARTFIRE 

 

If the simulation case has been run with a fairly course mesh, then we cannot totally rely on 

the results for any safety critical assessment of the modelled scenario. Also we may not have 

been very exacting about ensuring complete convergence (although a brief examination of the 

end of time step convergence history - the Time Step Residual Graph - indicates that most of 

the time steps ended at a reasonable state of convergence for this simulation). However we 

can use the results or data from the simulation to give a better understanding of the behaviour 

that we are likely to meet from this scenario. 

 

The purpose of the simulation was to get a rough indication of the times before the rooms, 

neighbouring the fire, experienced conditions that are threatening to life and to compare this 

with the results from Tutorial 4, which did not have an extractor Fan. We are only 

considering the effect of temperature in the modelled scenario and effects such as smoke 

concentration, thermal radiation or the toxic gas concentration, are not considered. Again we 

can obtain a rough understanding of the fire effects by considering a typical harmful exposure 

time for a normal person to be approximately 1 minute at an air temperature of 180
o
C. 

Remember that the SMARTFIRE CFD Engine is calculating temperatures in Kelvin. If we 

assume that, for safety considerations, reaching a critical temperature of 120
o
C indicates the 

onset of dangerous - to human life - conditions. We can check through the plot graph data for 

the monitor line to determine at what time during the simulation each room experienced 

temperatures of 120
o
C (i.e. 393K) or more in the vicinity of the monitor line. 

 

Simple examination of the monitor line plot graph at the end of the simulation indicates that, 

even at the end of the simulation, the large room has not exceeded the critical temperature. 

Both of the monitored small rooms are experiencing temperatures in excess of 500K (i.e. 

227
o
C). 

 

Further analysis of the saved graph plot data files reveals the following times to reach the 

critical temperature. 

 

Monitored Room Time until first monitored 

cell above Tcritical 

Time until all monitored 

cells above Tcritical 

Large Room (with 

single window) 

134s 142s 

 

Small Room nearest to 

fire (with Fan) 

70s 102s 

Small Room furthest 

from fire 

120s 124s 

Table 25-74 Table of times to detect critical temperatures in monitored rooms. 

  

Unsurprisingly the extractor Fan has had an impact on the "safe" times for the monitored 

rooms, since a considerable amount of heat is being removed from the building via the small 

room that contains the Fan, whilst entrainment through the windows will have increased thus 

bringing more cool air into to the building. The large room experiences somewhat lower 

temperatures (for a longer period) than were experienced when no Fan was used. If the Fan 

extraction rate was increased, so the duration for safe occupancy would also be further 

increased. 
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It should be noted that this tutorial is not intended to give an exacting study into the fire 

safety considerations pertaining to a single fire modelling scenario but, rather, give an 

indication of the nature of possible simulations and the types of questions that can be asked of 

the simulation results. 

 

25.6.7 STEP 6: EXITING THE CFD ENGINE 

 

To exit the code, simply exit the CFD engine interface using the [Exit] button. On normal 

termination, the SMARTFIRE CFD engine will save a number of files that can be used for 

further visual post-processing (abnormal termination will not save any files and is 

encountered when the main window [X] button is pressed. Finally the CFD engine user 

interface will close and you will get back to the original geometry set-up tool. If you want to 

save any changes you have made to the fire modelling case, select the [File] item and then the 

[Save] option from the main menu. 

 

It is interesting to note that the case directory (for a completed simulation) will contain many 

files that have been created during this exercise. Some of these files can be used for graphical 

post-processing and for re-starting this simulation from the stage when it was exited. Also 

there may be data capture files saved during your simulation.  

 

You are advised to check the contents of the working case directories because the disk usage 

can be significant, particularly for large cell budget simulations. 

 

This is the end of Tutorial 5. 
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25.7 TUTORIAL 6 

 

 

25.7.1 OVERVIEW 

 

 

This tutorial extends the scenario that was used in Tutorial 4 to use a gaseous combustion 

model for the fire and to use the more accurate multiple ray radiation model instead of the 

default six-flux radiation model. All of the other geometry and scenario specifications are 

identical to those in Tutorial 4 except for the changes required to the fire source to apply a 

mass release rate of a gaseous fuel. 

 

  

Figure 25-75 Plan view drawing showing the room layout geometry. 

 

As with the Tutorial 4 scenario, certain assumptions have been made to simplify the 

specification as follows: 

 The rooms are all assumed to be open plan during the fire simulation so all of the 

doorways and windows are fully open for all of the simulation. 

 The doors on the end of the corridor are assumed closed throughout the simulation and 

they are of sufficient strength that the fire will not affect their structural integrity. There 

are actually windows present on the large outer wall of the largest room but these are 

assumed closed (and are hence not modelled) during the period of the simulation (in 

practice this cuts down the requirement for an additional extended region and hence 

makes the simulation run faster). 

 Small air leaks around closed doors or windows are ignored and the heat transfer 

through the walls is considered to be negligible compared to heat transfer due to other 

processes, in the duration of the simulation. 
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 The corridor is assumed to have no combustible materials, which can support fire 

spread or secondary ignition.  

 

The geometry of this case could be constructed from scratch but it is recommended that the 

user actually loads the SMARTFIRE model file created for Tutorial 4, and immediately re-

saves it as a newly named case and then modifies the problem settings and the fire properties. 

 

Again the fire is assumed to be a cleaning trolley fire at one end of the corridor. The fire will 

be specified as an equivalent methane fire that reaches a fuel release rate that is equivalent to 

the peak heat release rate of 2MW in two minutes, used in Tutorial 4. Since the fire is in the 

corridor and will prevent conventional means of egress from the building, we are actually 

interested in determining the times to reach a critical temperature (at about head height) in the 

neighbouring rooms where there are no exterior doorways to use for exit. This data will be 

compared to the results to Tutorial 4 to investigate the effects of using combustion and the 

multiple ray radiation models. 
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25.7.2 STEP 1: LOADING THE BASE CASE AND RENAMING 

 

Run the SMARTFIRE case specification tool. Once the graphical user interface has opened, 

use [File] and [Open] to open the file loading menu. Use the file loading dialog window to 

browse to the folder containing the tutorial case from Tutorial 4 (probably called "t_4" or 

“tutorial_4”), typically found in the "smartfire\work" folder. Select the SMARTFIRE model 

file for this case (i.e. named "t_4.smf" - if using the naming convention suggested in Tutorial 

4), and select the [Open] button. The base case from Tutorial 4 will be loaded and the default 

3D wire frame view of the case will be displayed. 

 

In order to prevent any subsequent scenario modifications from being accidentally written 

back into the Tutorial 4 case, it is recommended that the case is immediately renamed by 

selecting the [File] and [Save As] option. Use the file save dialog to browse back up to the 

"smartfire\work" folder - since you will currently be INSIDE the "t_4" folder, and enter the 

name "t_6" in the File name field and select the [Save] button. The case will be renamed and 

a newly named "t_6.smf" model file will be saved in a new "t_6" folder. 

 

Now you can proceed to modify the settings to activate the combustion and multiple ray 

radiation models. 

 

 

Figure 25-76 Specification tool showing renamed case from Tutorial 4. 

 

25.7.3 STEP 2: ACTIVATING THE COMBUSTION MODEL 
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Select the [Scenario] option from the main menu and select the [Problem Type] settings. In 

the Problem Type Options window activate the combustion model by ticking the check box 

for the "Combustion Model". 

 

 

Figure 25-77 Problem Type options showing the activation of the combustion model. 

 

All of the other Problem type options can be left to the settings used in Tutorial 4. I.e. 

Transient simulation using 150 time steps of 2.0 seconds per time step with 50 sweeps per 

time step. The convergence tolerance is set to 0.001. The default wall thickness is 0.2 m. The 

Ambient temperature and the Initial temperature are set to 288.75K. The external pressure is 

101325 Pa and the building is set to contain "Standard_Air". 

 

Once the Combustion model has been activated, enter the combustion model settings using 

the [Setup...] button near the combustion model check box. This will open a window that 

shows the default settings for the combustion model. The default combustion fuel is for a 

methane fire, so none of the parameters should need to be changed BUT it is always 

advisable to check that the combustion parameters are set to the correct defaults since these 

settings are being loaded from a previous case that could have been modified. 
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Figure 25-78 Combustion model options. 

 

The combustion model should use the Eddy Mixing Controlled combustion. This is the more 

sophisticated combustion model since it links the combustion to the turbulence model. 

 

The molecular ratios in the combustion equation are correct for methane when the following 

parameters are used: 

 

1 CH4  +  2 O2  =>  2 H2O  +  1 CO2 

 

The fuel mass fraction in inlet is left as the default value of 1.0 (i.e. pure fuel inlet) and the 

oxygen mass fraction in inlet is set to the default of 0.23 (i.e. the normal ratio of oxygen in 

air). 

 

The Molecular weights are set to 16.0 for the Fuel (i.e. Methane = CH4 = Carbon
(a.w.=12)

 + 4 x 

Hydrogen
(a.w.=1)

 = 12 + 4 = 16) and 28.0 for the dilutant in Air (i.e. Nitrogen = N2 = 2 x 

Nitogen
(a.w.=14)

 = 28). N.B. the 
a.w.

 number represents the Atomic Weight of the atoms of the 

specified elements and is used to calculate the Molecular Weight. Typically the average 

Atomic Weight should be used taking into account the relative abundance of different 

isotopes of the element. 
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The Heat of Combustion for Methane in Air is 5.0e7 J/kg. The Combustion Efficiency is 

taken as the default 80% (i.e. 0.8) and the Eddy Break up constant is left as the default value 

of 4.0. The combustion oxidant limit specifies the fraction of oxidant in the atmosphere 

required to sustain combustion. This factor will only play a part for very fuel rich 

environments, limited ventilation environments or, possibly at the heart of a large fuel source 

volume. The default value equates to 14% (i.e. 0.14) of oxygen needed to sustain combustion. 

 

Now it is necessary to create an equivalent fire source for the release of gaseous fuel. The 

parameters that were used for the Heat Release Simple Fire were for an initial 50 kW raising 

to 2 MW after 120.0 seconds. The time equation parameters were A=50.0, B=0.0, C=0.1285, 

D=0.0 and E=0.0 with Start time=0.0 and End time=120.0 seconds. The conversion is 

achieved by dividing the Heat release rate terms (of the volumetric heat release fire) by the 

Heat of combustion for the particular fuel being used. In this case we have 

A=150.0e3/5.0e7=3.0e-3 and C=0.1285e3/5.0e7=2.57e-6 (Remember that the terms were in 

kW but we need to do the calculation in Watts and Joules to give kg of fuel release rate). 

Entering these values into the Fire Properties window for the fuel release rate we obtain the 

following fuel-equivalent fire: 

 

 

Figure 25-79 Fire properties for the equivalent fuel release rate. 

 

25.7.4 STEP 3: ACTIVATING THE MULTIPLE RAY RADIATION MODEL 

 

Select the [Expert] option from the main menu and select the [Expert Options] item. This 

opens a simple dialog where there are two check boxes. The User must check the [Enable 
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Expert problem set up] as this unlocks some of the additional functionality, such as the 

Multiple Ray radiation model. This is necessary because the Multiple Ray Radiation model 

should not be used by novices on arbitrary cases since it is possible (with poor choice of rays 

or by particular geometrical alignments of fires and free surfaces, to decouple the fire from 

the free surfaces and thus make the multiple ray radiation model perform badly. Select the 

[Scenario] menu option and the [Problem type] item to access the Problem type options 

window. The radiation model should already be active from the previous tutorial. Select the 

[Setup…] option (near the Radiation check box) to enter the Radiation model options 

window. The multiple ray radiation model option is now available and can be selected using 

the appropriate radio button from the Radiation Model options window. 

 

 

Figure 25-80 Radiation model options window showing the selection of Multiple ray 

radiation using 24 rays. 

 

In this tutorial it is recommended that 24 rays are used to model the Multiple Ray radiation. 

 

25.7.5 STEP 4: CREATING A MESH FOR THE SIMULATION 

 

Once you are satisfied with the modifications to the physics handling of the case you need to 

run the mesh creation system. To run the automated meshing tool from the main menu, 

choose the [Run] option and the select [Create Mesh]. This will open the mesh creation tool 

user interface. The automated meshing tool will first determine if the current geometry 

already has an existing mesh previously created. If one is available then the user will be given 

the option to load the existing mesh or to create a new one. Since we have not actually 

changed the geometry from Tutorial 4, then it is permissible to use the existing meshing, if 

this is available. If an existing mesh is not available then it is quite a simple task to re-specify 

the mesh using the following instructions. 

 

Once all of the geometry and modelling issues have been resolved, the meshing system will 

analyse the geometry and present a Cell budget window. This has the automated meshing 

system's recommended cell budget with individual user-selectable cell budgets for each of the 

co-ordinate directions. It is recommended that this case be meshed as a course mesh (usually 

a good option for checking that a case has been correctly specified and that all of the physics 
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and numerics behave as expected). Unfortunately, for a course mesh, the meshing system will 

struggle to create a very even mesh. Hence we will use the manual mesh editor to selectively 

refine certain mesh blocks (mesh slices between and through objects) to give a reasonably 

even course mesh. The Cell Budget window appears as follows: 

 

 

Figure 25-81 Cell budget for meshing. 

 

The first attempt at meshing using a course mesh appears as follows: 
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Figure 25-82 First course mesh from the automated meshing system. 

 

This course mesh would only be appropriate for a quick test run of the simulation to check 

that the configuration is working as expected. For a production run, where accurate results are 

required, the user is recommended to use the [Refine+] button to ensure that the mesh is of 

sufficient quality.  

 

It would also be possible to manually refine the mesh to create a suitably even mesh by 

adjusting the numbers of cells in the mesh slices. It should be noted that the "slice" selection 

combo box and slice number spin box can be used to highlight a slice for refinement but it is 

generally easier to point at the required slice in the display windows and select (with the 

mouse pointer and button) to make the current slice active (highlighted with grey=internal 

region or green=external region shading). Each of the mesh display windows allows either of 

the displayed directions to be edited. The current block to be edited will be highlighted and 

the [Data] panel will allow the number of cells in that slice to be changed. 

 

There is no absolutely correct mesh for any simulation and, with experience, the user will 

eventually develop knowledge of when and where cells need to be refined. Generally the 

following points should be considered when manually refining a mesh. 

 

(1) The fire will be generating a highly buoyant plume that may lean over as air is entrained 

or channelled around obstacles. It is good practice to provide additional cells in the vicinity of 

the fire to give the plume as much freedom as possible. 

 

(2) Vents are likely to have higher speed channelled flows and will consequently benefit from 

having as many cells as possible across their height and width. 
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(3) Where a buoyant plume impacts a ceiling (or wall) there should be as many cells as 

possible to allow for plume rotation into ceiling jets. 

 

(4) It is not a good idea to have largely dissimilar sizes between adjacent mesh cells. 

 

(5) It is not a good idea to have very squashed (or elongated) mesh cells.   

 

The result of using the [Refine+] option on the mesh will give the following mesh: 

 

 

Figure 25-83 Manually edited and refined mesh. 

 

The mesh is now ready and can be saved for simulation. Pressing the [Accept] button will 

allow the mesh and scenario specification to be saved as a set of specification files for the 

CFD Engine to read. Pressing the [Accept] button will also cause the automated meshing tool 

to close and control will then return to the SMARTFIRE Case Specification Environment. 

 

25.7.6 STEP 5: RUNNING THE CFD ENGINE 

 

The final stage involves performing the numerical simulation itself using the CFD engine 

component of SMARTFIRE. To run the CFD engine select on the main menu item [Run] and 

the [Run CFD Engine] option. This will launch the numerical CFD engine that will 

automatically load the case specification and mesh that you have just created. You may have 

to be a little patient as this stage involves a considerable amount of file parsing, memory 

allocation and initialisation. Eventually the user interface for the CFD engine will appear 
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completely. It should be noted that if you are using a low resolution display then the CFD 

engine use-interface may display itself with more compact windows and a slightly different 

layout (e.g. with more of the windows initially closed) in order to create a usable display. 

 

Once the CFD Engine has loaded the data and performed all of the require initialisations then 

the User Interface will be displayed with the un-processed view of the simulation case. The 

initial CFD Engine display will appear as follows: 

 

 

Figure 25-84 SMARTFIRE CFD Engine user interface at start up. 

 

The Case Specification Environment will have selected a default view plane for the 

visualisation (typically at the halfway layer of cells in the X-direction). Unfortunately this 

view plane might not be a particularly interesting one to display, so it is worth selecting a 

good plane to view throughout the simulation. In this case we have not kept any information 

about what would be a good plane to select but we can use the visual configuration window 

to "find" a suitable plane. If we press the [Visual] button then the Visual Configuration 

Window will open and we can use it to investigate the arrangement of the objects so that a 

more interesting slice plane can be found. By selecting the lowest Y slice, we can see where 

the fire is located in the Visual Display window. 

 

It is then a simple matter of re-entering the Visual Configuration Window and selecting the 

planar slice that will give a more meaningful display of what is occurring in the vicinity of 

the fire. 
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Figure 25-85 Visual Configuration selecting the lowest Y-layer of cells to view. 

 

  
Figure 25-86 Visualisation of the lowest Y-slice of cells showing the fire location. 
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After selecting the X=22 slice (the exact index will depend on the mesh used but the user 

should check that it is through the centre of the fire) the following Visual Display will appear 

on the User Interface. 

 

 

Figure 25-87 SMARTFIRE User Interface after selection of a more interesting visual 

slice plane through the fire. 

 

It should be noted that the Visual Configuration Window could also be used to change the 

features that are displayed in the data Visualisation. In the image above the [Contour Fill] 

option of "TEMPERATURE" has been activated because this gives a clearer representation 

of the temperatures in the fire plane, especially when using vectors of velocity in the same 

display.  

 

Before starting the simulation it is worth considering the forms and frequency of data capture 

from the simulation. If the user merely wishes to see what conditions are like at a particular 

time then the simulation can simply be run until that required simulation time is reached. In 

our scenario we are not sure what time the conditions will occur so we need to save sufficient 

data to allow us to analyse at what time certain conditions were experienced. The user should 

open the [Configure] menu from the main menu and select [Data Capture]. This presents the 

Data Capture Configuration menu, where the frequency and nature of the data that will be 

saved during (and at the end of) the simulation, can be configured. In this simulation it is 

recommended that the user save the results, graphs and visuals at the end of every time step. 

This is configured by ticking the appropriate check boxes in the "Automatic Transient 

Outputs" section of the menu. 
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Figure 25-88 Data Capture Configuration menu. 

 

Now that everything has been configured it is possible to start the processing of the 

simulation scenario. 

 

In order to start the numerical simulation, you will need to press the [Run] button, marked 

with a GREEN (GO) icon. This will start the simulation process. To halt the simulation at any 

time, press the [Halt] button marked by a RED (STOP) icon. You can also terminate the 

simulation at any point by pressing the [Exit] button (showing a little door icon). There are a 

number of extra buttons and other controls that allow experts to intimately control the 

configuration of the solution process. However, non-experts are not recommended to make 

any changes to the control settings unless this is recommended in the user guide. 

 

The graphical windows of the user interface present various views of the data and the status 

of the simulation during the simulation process. The things to look for are: 

 

1) The residual graphs that are indicators of the convergence of the solved and calculated 

variables of the numerical simulation process (Top right). 

 

2) The monitor values and variable residuals (current solution error states) of various 

important variables are shown in the status window (Bottom left). 

 

3) The emerging vector flow and temperature contour patterns for the particular selected 

slice of the room in the Visualisation window (Bottom right). SMARTFIRE is now 

able to maintain multiple visualization windows, each containing completely 

independent view and display selections. 

 

4) The data ranges for each variable displayed in the status window (Bottom left). 

 

5) The control window has progress bars in its bottom right corner (below the 

visualisation buttons). These bars indicate solution progress. The upper bar is filled 

once every sweep whilst the lower bar is filled once for the whole configured 
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simulation (Top left). 

 

6) The status window has displays indicating the sweep number and time step number 

(only for transient simulations) to indicate the current stage of processing (Bottom 

left).  

 

7) The status window has estimates for the CPU time taken and remaining. These are 

only estimates but can give a reasonable approximation of the expected duration of a 

simulation (Bottom left). 

 

8) A key feature of SMARTFIRE is the access to save a bookmark and restart from 

saved bookmarks at any time. The control button labelled [Mark] will drop a 

bookmark of the current stage of the solution into a database for this case. The button 

labelled [Restart] allows a previous bookmark state to be loaded as if subsequent 

processing had not happened. This can be invaluable for problematic simulations that 

need expert solution control or simply for saving data for future examination (Top 

left). 

 

9) There is a control button labelled [Plots] that allows you to define line graphs through 

the data. These plot line graphs are updated as the solution progresses (Top left). 

There will be a single Plot window available to view that represents the monitor line 

that was created in the geometry specification. 

 

 

 

Figure 25-89 SMARTFIRE User Interface showing the end stage of the simulation. 
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25.7.7 STEP 6: INTERPRETING RESULTS FROM SMARTFIRE 

 

As with Tutorial 4, if the simulation has been run with a course mesh then we cannot totally 

rely on the results for any safety critical assessment. Again, we have not been very exacting 

about always ensuring complete convergence (although examination of the end of time step 

convergence history - the Time Step Residual Graph - indicates that most of the time steps 

ended at a reasonable state of convergence for this course mesh simulation).  

 

The purpose of the simulation was to get a rough indication of the times before the rooms, 

neighbouring the fire, experienced conditions that are threatening to life. We are only 

considering the effect of temperature in the modelled scenario and effects such as smoke 

concentration, thermal radiation or the toxic gas concentration, are not considered. Again we 

can obtain a rough understanding of the fire effects by considering a typical harmful exposure 

time for a normal person to be approximately 1 minute at an air temperature of 180
o
C. 

Remember that the SMARTFIRE CFD Engine is calculating temperatures in Kelvin. If we 

assume that, for safety considerations, reaching a critical temperature of 120
o
C indicates the 

onset of dangerous - to human life - conditions. We can check through the plot graph data for 

the monitor line to determine at what time during the simulation each room experienced 

temperatures of 120
o
C (i.e. 393K) or more in the vicinity of the monitor line. 

 

Simple examination of the monitor line plot graph at the end of the simulation indicates that 

all of the monitored rooms are experiencing temperatures in excess of 410K (i.e. 137
o
C). This 

is lower than the final temperatures found in Tutorial 4, by some 90
o
C. 

 

In this case we are also interested in seeing what effect using the multiple ray radiation model 

and the combustion model have had on the results that were found in Tutorial 4. As a 

reminder the results found from the Tutorial 4 simulation were as follows: 

 

Monitored Room Time until first monitored 

cell above Tcritical 

Time until all monitored 

cells above Tcritical 

Large Room (with 

single window) 

118s 126s 

Small Room nearest to 

fire 

78s 106s 

Small Room furthest 

from fire 

104s 116s 

Table 25-90 Table of times to detect critical temperatures in monitored rooms from 

Tutorial 4 (using volumetric heat release and six flux radiation). 
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Further analysis of the saved graph plot data files for Tutorial 6, reveals the following times 

to reach the critical temperature. 

 

Monitored Room Time until first monitored 

cell above Tcritical 

Time until all monitored 

cells above Tcritical 

Large Room (with 

single window) 

144s 156s 

Small Room nearest to 

fire 

126s 134s 

Small Room furthest 

from fire 

126s 140s 

Table 25-91 Table of times to detect critical temperatures in monitored rooms from 

Tutorial 6 (using combustion and multiple ray radiation using 24 rays). 

  

Now we see that the use of the combustion model and the multiple ray radiation model have 

apparently extended the safe times for the monitored rooms by times between approximately 

a half a minute (for the large room and the small room remote from the fire) to a minute (for 

the small room nearest the fire). The large variation in times is to be expected. The use of the 

combustion model and the multiple ray radiation model will, generally, give better 

approximations to the real conditions in the fire scenario, at the expense of considerable extra 

computation. In the Tutorial 4 simulation the CPU time used was 4h 0m and 27s, and for 

Tutorial 6, the CPU time used was 9h 3m and 16s, indicating that the combustion model and 

the multiple ray radiation model extend the CPU time used by at least double. It is also 

pertinent to ask if this accuracy is necessary for the particular usage of the results. In the 

analysis above we are looking for a safe time for room occupancy and it is probably 

acceptable to have a conservative estimate of this time, as we would by having slightly over 

estimated temperatures - typical of the volumetric heat release model for the fire. 

 

It should be noted that this tutorial is not intended to give an exacting study into the fire 

safety considerations pertaining to a single fire-modelling scenario but, rather, give an 

indication of the nature of possible simulations and the types of questions that can be asked of 

the simulation results. 

 

To reiterate, the decision about which modelling techniques and settings to use, can have a 

large impact on the results obtained from the simulations. It should be noted, however, that it 

is not always necessary to opt for the best available modelling techniques due to the, possibly 

unacceptable, protracted run-times or the fact that a known over- or under- estimate will give 

a conservative safety margin.  

 

25.7.8 STEP 7: EXITING THE CFD ENGINE 

 

To exit the code, simply select the [Exit] button on the user interface. On normal termination, 

the SMARTFIRE CFD engine will save a number of files that can be used for further visual 

post-processing (abnormal termination will not save any files and is encountered when a 

critical error occurs or when the main window [X] button is pressed). Finally the CFD engine 

user interface will close and you will get back to the original geometry set-up tool. If you 

want to save any changes you have made to the fire modelling case, select the [File] item and 

then the [Save] option from the main menu. 
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It should be noted that the case directory (for a completed simulation) will contain many files 

that have been created during this tutorial. Some of these files can be used for graphical post-

processing and for re-starting this simulation from the stage when it was exited. Also there 

may be data capture files saved during your simulation. Users should be aware that running 

many large simulations can rapidly fill up hard disks with results data. 

 

This is the end of tutorial 6. 
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26 SMARTFIRE ADVANCED TUTORIALS 
 

 

26.1 INTRODUCTION 
 

 

The following tutorials are intended for you to work through various aspects of 

building, running and analysing a CFD based fire simulation using SMARTFIRE. 

 

The first four cases involve a small scale geometry with two rooms connected by a 

corridor.  One of the rooms is vented to the outside.  These four cases explore 

increasing sophistication in the fire scenarios and allow the user to experience various 

capabilities of the tools. 

 

 Tutorial A1 involves setting a simple heat release rate fire source in one of the 

rooms with all connecting doors open. 

 Tutorial A2 uses the post processing and data analysis facilities of the 

SMARTFIRE CFD Engine to analyse the Tutorial A1 case. 

 Tutorial A3 uses output results from Tutorial A1 to investigate the post-

processing and animation facilities of the DataView tool. 

 Tutorial A4 uses gaseous combustion and involves setting a secondary fire 

source in the second room which ignites at a pre-set temperature. The 

connecting door is initially closed. 

 Tutorial A5 introduces CAD file import and allows a scenario to be created 

from a large scale floor plan diagram. 

 Tutorial A6 makes use of the parallel version of the SMARTFIRE CFD 

Engine to simulate the two room scenario. 

 

In all cases, the user is advised to take a note of the level of convergence that is 

achieved for the mesh that is being used.  These tutorials will mostly be using coarse 

meshes so that you will be able to see the outcome of the simulation in a reasonable 

time – but typically it is recommended that a production run would use much finer 

meshes (and consequently require proportionately longer processing times). 
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26.2 TUTORIAL A1 
 

 

26.2.1 GEOMETRY SPECIFICATION 
 

The geometry has three interconnected compartments as shown in the diagram below. 

 

In this Tutorial all of the doors are assumed to be open throughout the simulation. 

 

 

Figure 26-1 : Three room geometry with tall fire and open doors. 

 

26.2.2 SCENARIO SPECIFICATION 
 

Size the geometry region: 

 

Region size is (6.0, 2.5, 5.0). 

 

Create the following objects (using the Case Specification Environment): 

 

Long wall [OBSTACLE] 

 at (x=0.0, y=0.0, z=2.0) size (dx=6.0, dy=2.5, dz=0.1). 

 

Short wall [OBSTACLE] 

 at (2.95, 0.0, 2.1) size (0.1, 2.5, 2.9). 
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Open door [PORTAL open in Z] 

 at (1.1, 0.0, 2.0) size (0.8, 2.0, 0.1). 

 

Open door [PORTAL open in Z] 

 at (4.1, 0.0, 2.0) size (0.8, 2.0, 0.1). 

 

Open door [PORTAL open in X] 

 at (2.95, 0.0, 3.1) size (0.1, 2.0, 0.8). 

 

Open door [VENT on high X surface] 

 at (6.0, 0.0, 3.1) size (0.0, 2.0, 0.8). 

 

Fire [SIMPLE FIRE] 

 at (0.75, 0.0, 3.25) size (1.5, 1.5, 0.5). 

 

Select the Fire and Configure the Fire Properties as: 

 

Expert Heat release curve 

 with A=50, C=0.005 and END_T=300s (rising to 500kW). 

 

Configure the Scenario => Problem Type as: 

 

Flow, Heat and Six flux radiation, 

Transient with 30 time steps of 10 seconds, 

50 sweeps per time step. Select OK the accept the settings. 

 

 

26.2.3 MONITORING 
 

Create the following Monitoring Objects: 

 

Create plot graphs [MONITOR LINE objects] for 

 

1) TEMPERATURE distribution against Y-COORD. 

 

and 

 

2) horizontal velocity distribution against Y-COORD along the vertical centre 

line of each of the four doors. 

 

3) TEMPERATURE distribution against Y-COORD for a vertical stack in the 

centre of the corridor. 

 

Note that the horizontal velocity component will depend on the direction of 

the opening so an X facing opening will have the U-VELOCITY as the 

horizontal velocity component. 

 

Save these distributions at 30 sec, 1, 2 and 3 minutes by setting 

Scenario => Output Control => Use Transient Graph Save 
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Set the save interval to every 30 seconds (or every 3 time steps). 

 

This will create files named as follows: 

“plot_t_data_#plot_num_@#time.gpd” 

 

 

26.2.4 DATA GATHERING 
 

(IMPORTANT --- FOR TUTORIAL A3) 

 

Configure result file saves at 10 sec intervals using 

Scenario => Output Control => Use Transient Results Save 

 

Set the save interval to saving at every time step (i.e. every 10 seconds). 

 

 

26.2.5 MESH AND SIMULATE 
 

Meshing options: 

 

Save the case as “tut_case_A1”. 

 

Select Run => Create Mesh. 

 

Choose to ignore overlaps (we want PORTALS to make openings through 

walls). 

 

Select the geometry type as “Standard Room Geometry”. 

 

Stop the meshing system from adding an extra extended region in Y+ 

direction. 

 

Choose Cell Budget for Meshing as “Recommended mesh” with the “Refine” 

option. 

 

Accept the mesh (this will create script files for the SMARTFIRE CFD 

Engine). 

 

Run the simulation: 

 

Select the Run => Run CFD Engine. 

 

Wait for the CFD Engine to initialise and open fully. 

 

Press the [GO/Run] button to start the simulation. 

 

Stop and examine data/settings at any time with the [Stop] button. 

 

DO NOT exit or close the CFD engine at the end of the simulation as you 

will need SMARTFIRE in this end simulation state for TUTORIAL A2. 
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26.2.6 RESULTS AND ANALYSIS 
 

Results/Observations: 

 

What is the maximum temperature at the end of the 3 minute simulation? 

 

Take a note of the level of convergence that has been achieved. 

 

Do you think this represents an acceptable level of convergence? 

 

Ensure that you have saved the monitored data, i.e. the temperature and 

horizontal velocity distribution through the vertical centre line of each of the 

doors and the vertical temperature distribution in the centre of the corridor at 

30 sec, 1,2 and 3 minutes into the simulation. 

 

You will need this data to compare with the other tutorial case. 
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26.3 TUTORIAL A2 
 

 

26.3.1 RUTIME DATA ANALYSIS IN THE INTERACTIVE CFD ENGINE 
 

In this Tutorial you will use some of the data analysis tools in the SMARTFIRE CFD 

Engine to post-process and analyse the data from your existing Tutorial Case A1 

simulation. It is assumed that Tutorial Case A1 has now finished running and that the 

CFD Engine is waiting at the end of the simulation. 

  

The analysis tools used are: 

 The Data Explorer, 

 Plot Graphs and the 

 Function Solver 

 

 

26.3.2 DATA EXPLORER 
 

(Please remember that mouse click/drag on the visual area rotates/resizes the 

geometry) 

 

 

Figure 26-2 : The SMARTFIRE Data Explorer window. 
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Press the [Explore] button or select Display => Explore Data. 

 

Expand the size of the explorer window as much as possible and drag the centre bar to 

the right in order to see all of the available data tools. 

 

Use the Min- and Max- value and the Max- residual buttons to “find” the cell which 

has the maximum pressure, the minimum density, the maximum enthalpy residual and 

the maximum temperature. Record the cell number and its co-ordinates position (this 

allows comparison with a different mesh). 

 

 

26.3.3 PLOT GRAPHS 
 

 

Figure 26-3 : The SMARTFIRE Plot Definition window. 

 

Press the [Plots] button or select Display => Define Graphs. 

 

Increment the Plot Index until you find a graph that is not yet active. (This avoids 

changing existing plots from the Case Specification Environment). 

 

Activate this new graph definition using the [Active] tick box. 

 

Name the plot as “horizontal T profile” so that you will recognise it. 

 

Use the start and end coordinate positions to create a graph line that passes through 

the two rooms in the middle of the doors and just below the top of the doorway. i.e. 

between the points ( 0.0, 1.9, 3.5 )  and  ( 7.0, 1.9, 3.5 ). 
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Select the vertical graph axis to be a [USE VAR] TEMPERATURE. 

 

Select the horizontal graph axis to be [X-COORD]. 

 

[Apply] the settings and open the new graph plot window. 

 

In order to save the graph plot data to file select [Results], tick the [Save Graph Data] 

check box and the press [Save Now]. This will save a file for each plot, and name 

them as: 

“g#plot_index_#save_index.gpd”. 

 

 

26.3.4 FUNCTION SOLVER 
 

Open the Function Solver window using: 

Display => Function Solver. 

 

Select and drag on the visual area to rotate the geometry so that you can easily see 

into the fire compartment. 

 

Select region by volume and set the start and end coordinates so that the bright green 

outline box is just inside of the fire compartment walls. 

 

 

Figure 26-4 : The SMARTFIRE Function Solver window. 
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Set the calculation and scaling to VOLUMISED AVERAGE from the pull down 

menu. 

 

Use the Simple Variable Evaluator area to choose the selected variable 

TEMPERATURE. 

 

Press the [Calculate] button to see what the volumised average temperature is in the 

fire compartment. The result will be shown in the “Result =” box. 

 

Also determine the average upper layer temperature. To do this you will have to 

decide on the average height of the hot layer. This is not always easy to do although 

you might find that cut-plane visualisations or plot graphs help to determine where 

there is a sharp change in temperature between the lower (cooler) layer and the upper 

(hotter) layer. 

 

 

Figure 26-5 : Using the Function Solver window to select a sub-region. 

 

Select and drag on the visual area to rotate the geometry so that you can easily see the 

X facing door into the fire compartment. 

 

Select region by YZ Plane and set the plane x-coordinate and start- and end- 

coordinates so that the bright green outline box is just in the X-doorway of the fire 

compartment. 
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Figure 26-6 : Using the Function Solver to select the cells in a doorway. 

 

Set the calculation and scaling to SIMPLE SUMMATION from the pull down menu. 

 

Use the Simple Variable Evaluator area to choose the selected variable NET MASS 

FLUX. 

 

Press the [Calculate] button to calculate the Net Mass Flux into the fire compartment 

through the X doorway. The result will be shown in the “Result =” box. 

 

Now determine the mass inflow and mass outflow for the same door. Choose inflow 

or outflow from the variable list. 
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Figure 26-7 : Using the Function Solver to calculate the net flux through a 

doorway. 
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26.4 TUTORIAL A3 
 

 

26.4.1 POST PROCESSING VISUALIZATION USING DATAVIEW 
 

In this Tutorial you will need the “.VTK” and “.WRL” files that were saved during 

the Tutorial A1 simulation. If you have not saved any files you will need to repeat the 

processing of Tutorial A1 with the indicated result saving activated. 

 

Start the SMARTFIRE DataView program by launching its icon from the desktop or 

from the link in the SMARTFIRE Case Specification Environment. 

 

26.4.2 LOAD THE GEOMETRY 
 

Select FILE => Import VRML and navigate to the Tutorial A1 folder which will be 

inside smartfire\work.  

  

Load a “.WRL” file that was saved during the Tutorial A1 simulation. 

 

This will show a semi-transparent display of the geometry of the scenario. 

 

 

Figure 26-8 : The SMARTFIRE DataView program at start up. 

 

Use mouse selection and dragging on the display area to rotate/resize/move the 

geometry to give the most appropriate (clearest) view 
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26.4.3 PREPARE FOR ANIMATION 
 

Select the [Animation] panel and [Add Files…]. 

 

Select the files that you want to animate. 

 

Highlight the last data file and select [Load File] to actually load the last data set. 

 

 

Figure 26-9 : DataView showing loaded geometry and animation list of data sets. 

 

 

26.4.4 CREATE AN ANIMATED SCALAR VISUALIZATION 
 

Select the [Scalar] panel and activate scalar iso-surface display and choose 

TEMPERATURE. 

 

Choose an [iso-surface] and set a [value] for the surface (e.g. 700 K) and make the 

iso-surface semi transparent by setting the [Opacity] to 40 %. Add another iso-surface 

by changing the [No. of iso-surfaces] to 2 and setting the second iso-surface [value] to 

900 K. 

 

Create a title View => Title (e.g. “Tutorial A3”). 

 

Return to the animation panel and enter a [name] (e.g. iso_anim) then press the 

[Create] button. The DataView program will now start to load each of the result (.vtk) 

files in turn and save a static image for each data set. 
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Figure 26-10 : DataView showing Temperature Iso-surface, title and time. 

 

26.4.5 CREATE AN ANIMATED VECTOR VISUALIZATION 
 

Once the previous animation has been successfully created, deactivate the iso-surface 

display and instead create an animation of a vector slice from the [Vector] panel. 

 

Remember to change the title View => Title, if the previous title is now inappropriate 

for the new vector visualisation. 

 

Once you have the required static vector display return to the animation panel and 

enter an animation [name] (e.g. vec_anim), then press the [Create] button. 

 

 

26.4.6 VISUALIZATION NOTES 
 

When investigating the configuration panels try setting/ticking the different options 

and note the effect on the visualization display. 

 

You WILL NOT be able to visualize smoke for this tutorial because no smoke was 

saved in Tutorial A1.  

 

You will be able to see smoke visualization from the data saved later in Tutorial A4. 

 

Of course you can also simply use the DataView program to load and display a single 

data file, in which case use the File => Open option to select the required .VTK 

results file. 
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26.5 TUTORIAL A4 
 

 

26.5.1 COMBUSTION MODELLING 
 

In this Tutorial, the scenario from Tutorial A1 is extended to use triggered events 

(secondary fire ignition and opening of doors) and combustion modelling. 

 

The geometry is as shown below: 

 

Figure 26-11 : Tutorial A4 Geometry showing modified fires, door and trigger 

cell. 

 

 

26.5.2 MODIFY TUTORIAL A1 SCENARIO 
 

Load the base geometry and configure the new physics: 

 

Case is similar to Tutorial A1 with modified/additional objects, so load Tutorial A1 

and save as “tut_case_A4” – to avoid any confusion. 

 

Configure the Scenario => Problem Type with the following changes to the Tutorial 

A1 set-up (in the Problem Type configuration window): 

Enable (a) Combustion model and (b) Smoke model 
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Leave all the default settings for the configuration of the Combustion-, Smoke- and 

Six Flux Radiation- models. 

 

In order to use triggering, check that expert options are enabled. 

Expert => Expert Options => Enable Expert Problem Set-up. 

 

 

26.5.3 CASE SPECIFICATION 
 

Create and modify the following objects: 

 

Closed door [THIN PLATE in X direction] 

 at (2.95, 0.0, 3.1) size (0.0, 2.0, 0.8). 

 

Trigger cell [TRIGGER CELL] 

 at (4.45, 2.3, 3.45) size (0.1, 0.1, 0.1). 

 

Configure THIN PLATE “closed door” timed Activation as: 

“Active until end” time of 20.0 seconds. 

- Note that plate removal actually “opens” the doorway. 

 

Configure the TRIGGER CELL for activation as: 

TEMPERATURE     GREATER THAN     500 

- Note that all Temperatures are in Kelvin (i.e. K = oC + 273.15). 

 

Configure the fuel release of the fire as follows: 

 

Resize the [SIMPLE FIRE] so that the fire height is now 0.3m. 

 

Set the current [SIMPLE FIRE] duration from 0.0 to 100.0 seconds. 

 

Set simple t2 fuel curve 

 with C = 2.5e-6 (equivalent to peak 1 MW HRR fire). 

 

Check the fire statistics to ensure that the fuel curve is correct. 

 

Create and configure the Secondary Fire as: 

 

Create a Secondary fire [SIMPLE FIRE] 

 at (3.75, 0.0, 3.25) size (1.5, 0.3, 0.5). 

 

HINT: Easy way to create this fire is to “clone” the first fire and change position. The 

fuel (or HRR) curve will be the same as for the copied fire source. 

 

Check that the fuel mass release is the same as for the first fire. 

 

Configure fire activation as “Activated by Trigger” and select the only trigger 

name from the pull-down list of available trigger objects. 

 

Configure regular data captures as follows: 
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Check that results will be saved by times rather than time step numbers by 

ticking: 

Expert => Expert Options => Use times for data saves 

 

Select result saves for every 10 seconds of simulated time using: 

Scenario => Output Control => Use transient result saves, with the 

save interval set to 10 

 

 

26.5.4 MESH AND RUN THE SIMULATION 
 

Configure graph plot creation (data monitoring) 

 

as for Tutorial A1. 

 

 

Meshing options: 

 

Check case saved as “tut_case_A4” and select Run => Create Mesh. 

 

Choose to ignore overlaps since they are all intentional. 

 

Select the geometry type as “Standard Room Geometry”. 

 

Stop the meshing system from adding an extra extended region in Y+ 

direction. 

 

Choose a Cell Budget for Meshing as “Recommended mesh” with the 

“Refine” option enabled. 

 

Accept the mesh (this creates script files for the SMARTFIRE CFD Engine). 

 

Run the simulation: 

 

Select the Run => Run CFD Engine option. 

 

Wait for the SMARTFIRE CFD Engine to initialise and open fully. 

 

Press the [GO/Run] button to start the simulation. 

 

Stop and examine data or settings at any time with the [Stop] button. 

 

 

26.5.5 RESULTS ANALYSIS 
 

Results/Observations: 

 

Examine the “tut_case_A4.log” file to see when the second fire ignited. 
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HINT search for “CHANGED VOLUME PATCH” and examine the sweep 

information just above it to see when the event actually triggered. 

 

What is the maximum temperature at the end of the 3 minute simulation? 

 

Take note of the level of convergence that was achieved. 

 

Do you think that this is an acceptable level of convergence? 

 

Did you notice how the convergence affected when the door was opened and 

when the second fire ignited? You should notice that the simulation becomes 

less stable when the door first opens. 

 

As with Case A1, Note the temperature and horizontal velocity distribution 

through the vertical centre line of each of the doors and the vertical 

temperature distribution in the centre of the corridor. This data should be 

available for 30 seconds, 1, 2 and 3 minutes into the simulation. 

 

Compare these results with the results from the previous simulation. With 

combustion and a radiation model enabled, you should initially see lower 

temperatures than when using a heat release rate model. The temperatures will 

rise significantly when the second fire has ignited. 
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26.6 TUTORIAL A5 

 

26.6.1 CAD IMPORT TUTORIAL 
 

This tutorial introduces the SMARTFIRE Scenario Designer and uses it to generate a 

scenario from part of a large scale building plan that is a DXF 2D floor plan layered 

CAD drawing. 

 

 

Figure 26-12 : SMARTFIRE Scenario Designer showing loaded CAD floor plan. 

 

Load the supplied CAD floor plan into the Scenario Designer: 

 

Run the Scenario Designer and select File => Import DXF… 

 

Load the file “\smartfire\tutorial\CAD_DXF_geometry\dread0.dxf”. 

 

Ensure Settings => Units are millimetres. 

 

Set the Settings => Grid Spacing to 500. 

 

Use DXF => Layers to Disable NEW_WALLS and STAIRS. 
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26.6.2 CREATE FLOOR PLAN 
 

Create a Scenario Designer Floor Plan: 

 

Select the Object => Storey and draw a selection box around a part of floor 

plan from the top left corner to about 1/3 across and 1/3 down, which encloses 

the top-left wide room, part of the corridor and the four rooms below it. 

 

Go into Edit DXF Floor Plan mode and add a line across the corridor to help 

the room locator find the “open ended” corridor. 

 

Disable the box in the top-left long room by selecting it and then 

DXF => Disable Selected (since this would confuse the room locator). 

 

Return to Edit Building Model Floor Plan mode. 

 

Find / Add rooms to the Scenario: 

 

Check the Object => Default Properties. 

 

Check “storey” height=2.5m, “door” height=2.0m and width=0.8m. 

 

Select Tools => Locate Rooms and draw a selection box around the whole 

storey. 

 

Choose OK to find rooms and draw a line to indicate the “width” of a 

reasonably wide doorway. 

 

Room locator should find 6 rooms as in the floor plan. Add these to the 

scenario. You may need to edit the corridor “room” object so that it is not 

touching the top room object by dragging the edge of the room slightly. 

 

 



SMARTFIRE TUTORIAL GUIDE 

 

 

 114 

 

Figure 26-13 : Scenario Designer showing zoomed sub-region for scenario model. 

 

Add other objects to the Scenario: 

 

Select Object => Fire and draw a “box” for the fire in the long room. 

 

In selection mode (arrow) right click on Fire, select Properties and set height 

to 1.5m in the properties pop-up menu. 

 

Select Object => Door and click on the plan to add doors to the gaps in the 

walls. 

Hint: select middle of the gap and only needed on one edge of a wall. 

 

Use Scenario => Add Building to add all objects to the scenario. 

 

Select File => Create Smartfire Simulation. 

 

Give the case a name (e.g. “tutorial_a5” or “dread0_t5”) and proceed to the 

Case Specification Tool where the scenario can be finalized and meshed. 

 

Also you might like to try to create a scenario from another section of the floor 

plan. 
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26.7 TUTORIAL A6 
 

26.7.1 USING PARALLEL SMARTFIRE 
 

The following tutorial is intended to take you through building, running and analysing 

a CFD based fire simulation using parallel SMARTFIRE. 

 

The case involves a small two room geometry connected by a corridor.  One of the 

rooms is vented to the outside.  CAD import will be used to construct the case from a 

floor plan diagram. 

 

The tutorial uses the Scenario Designer to build the geometry, the Case Specification 

Environment to configure and mesh the case and the parallel version of the CFD 

Engine to run the scenario in a variety of configurations.  

 

For comparison purposes, it is essential that you ensure that all the settings for the 

simulations are identical. (The same as for Tutorial A1). 

 

You need to ensure that both MPICH and SMARTFIRE are installed correctly on all 

the machines that will be used in the parallel computation. 

 

 

26.7.2 LOAD DXF FLOOR PLAN 
 

Load a DXF geometry floor plan into the Scenario Designer: 

 

This part of the tutorial is intended to practice the use of the CAD interface 

(i.e. the SMARTFIRE Scenario Designer) to generate the scenario to be used 

in parallel SMARTFIRE. 

 

Run the Scenario Designer and select File => Import DXF… 

and choose to load the file: 

“\smartfire\tutorial\CAD_DXF_geometry\cad_geometry.dxf” 

 

The floor plan should appear as in the figure below: 
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Figure 26-14 : Simple CAD floor plan representing Tutorial A1 Scenario. 

 

26.7.3 CREATE SCENARIO 
 

Create the scenario in the Scenario Designer: 

 

Ensure Settings => Units are metres and set the Settings => Grid Spacing to 

0.05. 

 

Use DXF => Layers to delete the DOORS and disable the FURNITURE. 

 

Use Object => Storey, Draw storey box around the whole floor plan. 

 

Check the Object => Default Properties.  

 

Check “storey” height=2.5m, “door” height=2.0m and width=0.8m. 

 

Select Locate => Rooms, Draw a search region around the geometry. 

 

Choose OK to find rooms, Draw a line to indicate doorway “width”. 

 

Tool should find 3 rooms as in the floor plan. 

 

Select Object => Fire. Draw a box over the greyed furniture item. 

 

In selection mode (arrow) right click on Fire, select Properties and set height 

1.5m. 

 

Select Object => Door, click to add doors to the gaps in the walls. 

Hint: select the middle of a gap and only on one edge of a wall. 
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You should arrive at the following floor plan: 

 

 

Figure 26-15 : Scenario Designer floor plan with door and fire objects. 

 

Create the SMARTFIRE Scenario: 

 

Select Scenario => Add storey to add this storey to the model. 

 

Select File => Preview SMF – this should look almost identical to Tutorial 

A1. 

 

Select File => Create SMARTFIRE simulation to pass the scenario to 

SMARTFIRE 

 

Name the case “tut_case_A6” and this will save the “tut_case_A6.smf” file in 

a new “smartfire\work\tut_case_A6” folder. 

 

The Case Specification Environment will launch automatically with the 

geometry loaded. 

 

 

26.7.4 RUN THE PARALLEL CFD SIMULATION 
 

Run the simulation in the parallel MPI version of Smartfire: 

 

Run parallel SMARTFIRE using: 
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Run => Run Parallel CFD Engine. 

 

This will launch the parallel launcher for the configuration of the parallel run. 

 

Ensure that the data is saved at the correct time intervals (i.e. every 30s) for 

comparison with data from Tutorial A1. 

 

 

 

26.7.5 EXERCISES FOR PARALLEL SMARTFIRE TUTORIAL 
 

Results/Observations: 

 

What is the maximum temperature at the end of the 3 minute simulation? 

 

Take note of the level of convergence that has been achieved. 

 

Have you reached an acceptable level of convergence? 

 

How does the level of convergence compare with Case A1? 

 

Are there differences in the convergence quality of the serial and parallel 

results? 

 

Ensure that you have saved the temperature and horizontal velocity 

distribution through the vertical centre line of each of the doors and the 

vertical temperature distribution in the centre of the corridor at 30 sec, 1, 2 and 

3 minutes into the simulation. 

 

How do these results compare for the serial and parallel cases? 

 

How do the results compare for the coarse and fine mesh? Also compare cell 

budgets. 

 

Are the coarse results acceptable? 

 

What conditions would you place on this level of acceptability? 

 

 


